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1 Introduzione
Aladin è un atlante celeste interattivo che permette all'utente di visualizzare immagini 
astronomiche digitali  e sovraimporre i  dati  dei cataloghi  e dei  database  astronomici. 
Sono disponibili la maggior parte dei cataloghi e delle immagini accessibili in rete, tra 
cui SIMBAD, NED, VizieR, MAST/STScI, CADC, HEASARC,  SLOAN, NVSS…
Aladin è dedicato agli astronomi professionisti, ma nella sua versione semplificata, è un 
utile strumento didattico utilizzabile da insegnanti, studenti e astrofili.
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Aladin è un software  gratuito con licenza UdS/CNRS (vedi copyright),  disponibile  in 
Inglese, Francese, Italiano, Tedesco, Persiano, Russo e Cinsese.

Aladin è utilizzato per:
 Visualizzare e consultare immagini e cataloghi; 
 Esplorare i dati astronomici disponibili; 
 Preparare le osservazioni
 Creare mappe celesti

Aladin può essere utilizzato direttamente online per la visualizzazione dinamica dei dati 
astronomici, all'interno dei più comuni browser come Internet Explorer o Firefox.
Molti istituti distribuiscono in questo modo i dati ai loro utenti (NED, CADC, MAST, 
ESAC, ESO...). 

Aladin è  sviluppato  dal   Centre  de  Données  astronomiques  de  Strasbourg  (CDS).  E' 
compatibile  con  i  più  comuni  sistemi  operativi  inclusi  windows,  Linux  e  Mac.  Non 
richiede  particolari  risorse,  tranne  nel  caso  in  cui  si  elaborino  cataloghi  di  notevoli 
dimensioni (centinaia di migliaia di oggetti).

Ideato nel 1999, Aladin supporta gli standard emergenti dell'Osservatorio Virtuale.  E' 
compatibile con altri software di analisi e visualizzazione dati (IDL, VOPlot, TOPCAT, 
Specview, Splat,  VOSpec ...).   Tutte queste caratteristiche fanno di Aladin un potente 
strumento per l'esplorazione e l'integrazione dei dati, oltre che uno “science enabler??”

Il sito web di Aladin è: http://aladin.u-strasbg.fr. 

2 Installazione

L'installazione  di  Aladin  dipende  dalla  configurazione  del  proprio  pc,  in  ogni  caso, 
richiede solo pochi secondi.

Installazione locale

Aladin richiede pochi Mb di spazio su disco e 256 Mb di memoria RAM sono sufficienti 
per la maggior parte delle situazioni. 

Windows
URL: http://aladin.u-strasbg.fr/java/Aladin.exe

Con il sistema operativo windows l'installazione più facile e veloce consiste nella copia 
del file “Aladin.exe” in una cartella, o anche direttamente sul desktop.

Mac  
URL: http://aladin.u-strasbg.fr/java/Aladin.dmg
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L'installazione  sul  sistema  operativo  Mac  utilizza  un  classico  pacchetto  “dmg”: 
scaricarlo, aprirlo, e copiare il file “Aladin.app” nella cartella delle applicazioni.

Linux    e altri sistemi Unix  
URL: http://aladin.u-strasbg.fr/java/Aladin.tar

L'installazione  sul  sistema  operativo  Linux  utilizza  un  classico  pacchetto  “tar”. 
Scaricarlo,  e  a  aprirlo  con  il  comando  “tar  xvf  Aladin.tar”  o  con  un'applicazione 
equivalente.

Nota: Aladin può essere utilizzato con dati locali. Comunque, è consigliabile avere una 
connessione a internet (≥ 512Kbit/s) per avere anche l'accesso ai database astronomici 
online. Per ulteriori dettagli sull'installazione di Aladin, o per scaricare l'ultima versione 
Beta, consultare la pagina web:

http://aladin.u-strasbg.fr/java/nph-aladin.pl?frame=downloading

Aladin applet

Aladin può essere utilizzato senza alcuna installazione, direttamente dal proprio browser 
web. Inserendo uno dei seguenti  URLs, il browser caricherà automaticamente il codice 
di Aladin e aprirà il programma nella finestra. Aladin è stato studiato per avviarsi il più 
velocemente possibile  (circa 2 megabytes).

 France – Strasbourg (CDS) : http://aladin.u-strasbg.fr/java/nph-aladin.pl
 Canada – Victoria (CADC) : http://vizier.hia.nrc.ca/viz-bin/nph-aladin.pl
 United Kingdom – Cambridge: http://archive.ast.cam.ac.uk/viz-bin/nph-aladin.pl
 Japan – Tokyo (ADAC) : http://vizier.nao.ac.jp/viz-bin/nph-aladin.pl
 India – Puna (IUCAA) : http://urania.iucaa.ernet.in/viz-bin/nph-aladin.pl
 USA – Harvard (see) : http://vizier.see.harvard.edu/viz-bin/nph-aladin.pl

E' necessario accettare l'esecuzione dell'applet (certificazione). In caso contrario Aladin 
si avvierà comunque, ma con funzionalità ridotte.
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3 Per iniziare
Per  illustrare  brevemente  le  potenzialità  di  Aladin  viene  qui  descritta  la  tipica 
successione di azioni e comandi necessaria per visualizzare immagini e cataloghi attorno 
a un oggetto astronomico.

1. Avviare  Aladin
2. Cercare un'immagine in banda visibile di M51
3. Caricare SIMBAD attorno a questo oggetto
4. Caricare il catalogo NOMAD attorno a questo oggetto
5. Visualizzare i dati (zoommare, spostare l'immagine)
6. Esplorare i dati e accedere alle misure originali
7. Salvare

Vediamo questi passaggi uno per uno.

Avviare Aladin (1)

L'avvio  di  Aladin  dipende  dalla 
configurazione  del  proprio  PC.  Su 
Windows  e  Macintosh,  fare  un  doppio 
click  sull'icona  dell'applicazione.  Con 
linux e altri sistemi Unix probabilmente è 
necessario  lanciare  l'applicazione  dalla 
riga di comando digitando:

Aladin

 Caricare i dati (2, 3 e 4)

Il  modo  più  semplice  per  caricare 
un'immagine in Aladin è utlizzare il menu
“File => Carica  immagine  astronomica  => 
DSS  => DSS from ESO",  e specificare un 
nome o una posizione nella finestra  che 
appare. Nel nostro esempio “M51”. 

Successivamente  premere 
“INOLTRA”.
La  finestra  aperta  nel  passaggio 
precedente  ora  visualizza  l'elenco 
dei  server  a  cui  Aladin  può 
accedere.  I  server  delle  immagini 
appaiono sul  lato  sinistro.  Infatti, 
il  passo  precedente  ha 
preselezionato  la  scheda 
corrispondente, in queto caso “DSS 
from  ESO”.  Sulla  parte  destra  ci 

4



sono i server dei database (SIMBAD, NED) e la maggior parte dei cataloghi astronomici 
VizieR.
Per caricare i dai di Simbad, selezionare la relativa scheda e senza modificare il valore 
dei  parametri  nei  campi  della  finestra  (identici  alla  posizione  precedente),  premere 
nuovamente  “CERCA”.  Per  caricare  un  catalogo  scriverne  il  nome  nella  finestra  di 
VizierR prima di inoltrare la richiesta. Nel nostro esempio, poiché NOMAD è una grande 
survey, è possibile selezionarlo direttamente nella scheda “Surveys” cliccando sulla riga 
corrispondente. Alla fine premere “INOLTRA”.

Visualizzazione dei dati (5)

La  visualizzazione  dei  dati  avviene  nella 
finestra principale di Aladin. Questa finestra 
è divisa in 4 parti:

1. La  catasta:  visualizza  tutti  i  dati 
scaricati in un serie di piani.  L'occhio 
dell'utente è in cima alla catasta e vede 
i piani attivati.

2. Lo  zoom: mostra  la  parte 
dell'immagine  attualmente  visibile, 
con il corrente livello e posizione dello 
zoom (rettangolo blu).

3. La  visualizzazione  (finestra 
principale): mostra  l'area 
dell'immagine visibile secondo lo zoom 
e  i  piani  attivati,  con  sovraimposti  i 
simboli grafici in corrispondenza degli 

oggetti delle tabelle e dei cataloghi caricati.
4. Le misure: mostra le misure e i dati relativi agli oggetti selezionati con il mouse 

nella finestra principale (magnitudine, parallasse…).

Attivazione  dei  piani: Un  piano  viene  abilitato  o  disabilitato  spuntando  il  piccolo 
quadratino alla sinistra dell'icona del piano nella catasta. E' anche possibile cambiare 
con il  mouse il  piano “in  primo piano” (cliccare  e  spostarlo)  per avere una migliore 
visualizzazione (p. es. un'immagine in cima alla catasta nasconde i cataloghi nei piani 
inferiori).

Impostazioni  dello  zoom  :   il  modo più veloce  di  adattare  lo 
zoom è utilizzare la rotella del mouse con il mouse posizionato 
nella finestre “visualizzazione” o “zoom”. Se il  vostro mouse 
non ha la rotella, potete utilizzare il menu a tendina appena 
sopra la finestra “zoom”.

Spostarsi  sull'immagine: per  muoversi  sull'immagine 
spostare con il mouse il rettangolo blu della finestra “zoom”.
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Centrare un particolare oggetto: il punto centrale della visualizzazione è rappresentato 
da  un  reticolo  (la  croce  magenta).  Il  modo  più  semplice  per  puntare  un  oggetto  è 
spostare su di esso il reticolo, cliccando sull'oggetto. Successivamente, zoommando, la 
visualizzazione sarà automaticamente centrata sull'oggetto.

Misure  e accesso ai dati originali (6)

Aladin visualizza, attraverso simboli grafici sull'immagine di sfondo, 
gli oggetti associati alle tabelle e ai cataloghi astronomici - in questo 
caso  SIMBAD  e  NOMAD.  Ciascuno  di  questi  oggetti  può  essere 
selezionato con il mouse (cliccando su di esso o creando un rettangolo 
per selezionare tutti gli oggetti all'interno).

Gli oggetti selezionati appaiono circondati da un piccolo quadratino 
verde.  I  dati  associati  sono  visualizzati  nella  tabella  nella  finestra 
delle misurazioni. Alcuni valori appaiono sottolineati in blu: si tratta di link web.

Cliccando su un link Aladin apre il browser web e visualizza informazioni aggiuntive. Il 
primo link  solitamente rimanda alla fonte originale dei dati.
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Salvare (7)

Aladin offre  molte  opzioni  per salvare  il  lavoro:  es.  catturare  la  vista  corrente  come 
immagine, creare un file eps per una pubblicazione scientifica, ecc. Usare il menu“ File  
=> Salva vista corrente => PNG” per creare un'immagine della vista corrente facilmente 
utilizzabile con altre applicazioni.

Dopo  questa  breve  introduzione  ad  Aladin,  vediamo  più  in  dettaglio  le  sue 
caratteristiche.

4 Sovraimposizioni disponibili
Aladin  lavora  principalmente  con  3  tipi  di  dati:  immagini,  cataloghi e 
sovraimposizioni grafiche. Questi dati sono visualizzati in una delle varie finestre. 
Per ognuno di questi elementi, Aladin dispone di una serie di strumenti.
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Definizioni:

 Un'immagine  astronomica è  una  matrice  rettangolare  di  valori  che 
rappresentano una regione del cielo.  Le immagini  astronomiche sono solitamente 
fornite  con  altre  informazioni  su  origine  e  calibrazione  (posizione  in  cielo, 
dimensione dei pixel, tipo di proiezione, …);

 Un catalogo astronomico è una tabella, o un insieme di tabelle, in cui ogni riga 
contiene informazioni su un oggetto astronomico chiamato "sorgente" (ID, posizione 
in cielo, misurazioni, ...);

 Una  sovraimposizione  grafica  è  una  delle  varie  forme  geometriche   (linea, 
cerchio, poligono, …) associata a una posizione in cielo;

 Una vista è  una  proiezione  dell'area  di  un'immagine su cui  sono stati  segnati  i 
simboli delle sorgenti dei cataloghi e/o sovraimposizioni grafiche;

 La posizione in cielo è considerata come una coppia di angoli (RA – ascensione retta, 
DEC – declinazione) che specificano una posizione sulla sfera celeste.  Aladin non 
considera la distanza dell'oggetto dall'osservatore.

Vengono  ora  descritte  brevemente  le  operazioni  disponibili  in  Aladin  su  immagini, 
cataloghi e sovraimposizioni grafiche.

Funzioni di trattamento delle 
immagini

 Intensità dei pixel (contrasto);
 Simmetria (verticale/orizzontale);
 Composizione immagini a colori (RGB);
 Creazione di mosaici;
 Immagini cubiche con più immagini della 

stessa zona di cielo;
 Ricampionamento (ri-proiezione 

dell'immagine in accordo con la 
calibrazione di un'altra immagine);

 Calibrazione astrometrica (per parametri 
o per stelle corrispondenti);

 Operazioni con i pixel (addizione, 
sottrazione, moltiplicazione, divisione, 
convoluzione, normalizzazione).

Nota:  In  caso  di  immagini  molto  grandi 
(alcuni Gb), sono disponibili solo le funzioni 
di base (istogramma e simmetria).

Funzioni di trattamento dei cataloghi

 Operazioni sulle sorgenti (selezione, filtri, ordinamento, contrassegno….);
 Disegno  di  simboli  grafici  in  accordo  ai  valori  di  alcune  misure  (es.  cerchi 

proporzionali  alla  magnitudine,  frecce  basate  sul  moto  proprio,  ellissi  con  gli 
errori...);

 Correlazione tra i cataloghi; 
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 Generatore di colonne;
 Calibrazione astrometrica del catalogo (senza coordinate celesti).

Funzioni di sovrapposizione  grafica

 Evidenziazione dei contorni;
 Strumenti grafici:

 misura della distanza;
 contrassegni;
 disegno a mano libera;
 testo;
 taglio dei grafici lungo un segmento o nella terza 

dimensione (per le immagini cubiche).
 Griglia delle coordinate;
 Sovraimpressione  del  campo  di  vista  degli 

strumenti;
 spostamento;
 rotazione.

Operazioni di visualizzazione 

 Sorgenti dei cataloghi, figure grafiche, immagini 
sovraimposte  ad  altre  di  sfondo  (con  il  supporto  del 
controllo della trasparenza);
 Zoom e centraggio dell'immagine;
 Visualizzazione  di  più  finestre 

contemporaneamente  (2,4,9 o 16);
 Sincronizzazione  delle  visualizzazioni  (stessa 

scala, stessa orientazione);
 Generatore di anteprime per una lista di oggetti;
 Visualizzazione a schermo intero.

Queste  operazioni  possono  esser  effettuate  attraverso 
l'interfaccia grafica. Come spesso accade in questo tipo 
di  software,  sono  disponibili  molte  alternative  per 
soddisfare ogni genere di utente:

1. La  barra  dei  menu  nella  parte  superiore  della 
finestra;
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2. La barra degli strumenti (elenco di pulsanti cliccabili);
3. Menu popup disponibili con il click  destro del mouse o CTRL + click (Mac);
4. Alcune scorciatoie da tastiera. 

Nota: E' anche possibile effettuare queste operazioni tramite linguaggio di script, come 
illustrato alla fine di questo manuale (see 7.1)

Vediamo le varie componenti dell'interfaccia grafica e come utilizzarle.

5 L'interfaccia grafica
Aladin offre una ricca interfaccia grafica che permette di raggiungere con pochi click le 
principali funzioni. Le due finestre principali sono:
 La “finestra principale” per la visualizzazione e la manipolazione dei dati;
 La “finestra di selezione del server” per accedere ai dati astronomici, locali o in rete.

Altre finestre permettono ulteriori controlli:
 Intensità dei pixel (contrasto);
 Generatore di contorni;
 Filtri sui cataloghi;
 Correlazione  tra cataloghi;
 Calcoli sulle colonne dei cataloghi;
 Calibrazione astrometrica;
 Ricampionamento dell'immagine;
 Operazioni aritmetiche sui valori dei pixel;
 Salvataggio dei dati;
 Preferenze dell'utente (configurazione);
 Modalità script.

Nota: Oltre  alla  versione professionale  è  anche  possibile  avviare  Aladin  in  modalità 
studente “undergraduate” o nella semplice versione “preview”, per adattare l'interfaccia 
alle esigenze dell'utente. Queste due modalità saranno illustrate in seguito.

5.1 La finestra principale
Aladin combina in una singola finestra la maggior parte dei componenti richiesti  per 
visualizzare e manipolare i dati: la barra dei menu, il riquadro per la localizzazione, il 
pannello  della  visualizzazione,  il  pannello  dello  zoom, la  catasta  e  il  pannello  per  le 
misure e i dati.
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Trucco:  Le  proporzioni  relative  delle  differenti  finestre  possono  essere  modificate 
trascinando l'icona “doppia freccia - “ sotto la barra degli strumenti. 

Tour guidato

Menu: Guida => Tour guidato di Aldin…
Guida => Mostrami come…

Per esplorare le varie funzioni Aladin offre un “tour guidato” accessibile dal menu 
“Guida”. Dopo averlo attivato, passare con il mouse sui vari elementi della finestra 
principale per visualizzare una descrizione delle componenti.
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Aladin  offre  anche  una  serie  di  “dimostrazioni”  disponibili  dal  menu  “Guida => 
Mostrami  come…”.  Una  finestra  di  dialogo  descrive  passo  passo  le  operazioni  e 
contemporaneamente  il  puntatore  del  mouse  si  muove  indicando  le  azioni 
corrispondenti.

5.1.1 La catasta

La catasta contiene tutti i dati caricati nella memoria e che possono essere visualizzati. 
La catasta è strutturata come una serie di “piani” posizionati uno sopra l'altro. L'utente 
(raffigurato tramite l'occhio) osserva i piani dall'alto sfruttando la trasparenza.

Tipi di piani

I piani possono essere di differenti tipi a seconda della natura 
dei dati che contengono. Sono contrassegnati da loghi specifici e 
facilmente riconoscibili.

Le visualizzazioni associate alla catasta

Nel caso più semplice la catasta contiene una sola immagine 
su  cui  sono  sovrimpressi  una  serie  di  piani  contenenti 
cataloghi. 

Ci sono due metodi per creare una visualizzazione:
 Cliccare su un piano e spostarlo nella finestra di visualizzazione
 Attivare il piano

L'attivazione di un piano viene effettuata spuntando il piccolo quadratino alla sinistra 
dell'icona del  piano nella  catasta,  o cliccando l'icona del  piano.  Quando un  piano è 
attivato la sua icona appare ombreggiata  . 

Riassumendo, l'attivazione di un piano crea automaticamente una visualizzazione con 
tutti  i  piani  superiori  proiettati  su  di  esso.  Disattivando  un  piano  ne  viene 
semplicemente nascosta la visualizzazione nella finestra corrente.

Se  ci  sono  più  piani  attivati 
simultaneamente,  il  piano  usato  come 
sfondo  per  le  proiezioni  ha  un  segno  di 
spunta  rosso,  mentre  gli  altri  piani 
appaiono con il segno di spunta nero.

Suggerimento : E'  possibile  creare  una 
visualizzazione  utilizzando  solo  un  piano 
contenente  un  catalogo,  senza  bisogno  di 
proiettarlo su un'immagine.
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Piani con immagini della stessa porzione di cielo possono essere confrontati  in molti 
modi:  un'immagine  può  essere  sovrimpressa  all'altra  modificandone  il  livello  di 
trasparenza (see  7.1). Con due o tre immagini si può  costruire un'immagine a colori, 
immagini multiple possono essere confrontate creando un'animazione.

     

E' possibile caricare nella catasta immagini e cataloghi che non si riferiscono alla stessa 
regione di cielo. Utilizzando una singola visualizzazione, è possibile passare tra differenti 
campi di vista cliccando sui relativi piani. Inoltre, utilizzando visualizzazioni multiple, è 
possibile  vedere simultaneamente differenti  campi di vista (vedi  Errore:  sorgente del
riferimento non trovata visualizzazioni multiple). 

Struttura gerarchica della catasta

La catasta  può essere  organizzata  in  una struttura  a  più livelli 
utilizzando le cartelle. Le carelle possono essere create dal menu 
Modifica → Crea una catasta di piani, e Modifica  → Inserisci in 
una nuova cartella della catasta. Queste opzioni possono anche 
essere raggiunte tramite un click destro del mouse sulla catasta.

Menu contestuale

La catasta ha un menu contestuale che appare con un click destro del mouse. Questo 
menu raccoglie le opzioni riguardanti i piani della catasta: selezionare gli oggetti di un 
piano, cancellare i piani, creare cartelle e inviare i piani ad altre applicazioni.

Selezionare i piani

Per  selezionare  un  piano  della  catasta  cliccare  sul  nome  del  piano  (a  differenza 
dell'attivazione del piano, che avviene cliccando il logo o spuntando il quadratino).
I piani selezionati sono evidenziati in blu. Più piani possono essere selezionati assieme 
premendo il tasto CTRL durante la selezione, o premendo il tasto SHIFT per selezionare 
piani consecutivi.
Quando un piano è selezionato alcune voci dei menu possono essere attive o disattive a 
seconda  della  natura  del  piano.  Per  esempio,  il  generatore  di  contorni  sarà  attivo 
durante la selezione di un immagine e disattivo durante la selezione di un catalogo. 
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Proprietà dei piani

Pulsante: prop. 
Menu : Modifica => Proprietà
Tastiera: Ctrl + Enter

Il  pulsante  “prop”  apre  una  finestra  con  le 
proprietà  del  piano.  Questa  finestra  è  anche 
raggiungibile dal menu  Modifica->Proprietà 
e dal menu contestuale della catasta.
La finestra delle proprietà fornisce il nome del 
piano e  l'origine  dei  dati  (l'indirizzo  web da 
cui  Aladin ha ottenuto i  dati),  oltre ad altre 
informazioni a seconda della natura del piano. 
In  questa  finestra  si  possono  modificare 
alcune  proprietà,  per  esempio  i  simboli  dei 
grafici e i colori dei piani dei cataloghi.  

Gestire la trasparenza dei piani

Alcuni piani possono essere visualizzati semi-
trasparenti  così  da permettere la visione dei 
piani sottostanti nella catasta.
Questo  è  utile  durante  il  confronto  tra 
immagini oppure durante la sovrimpressione 
dei  campi  di  vista  degli  strumenti.  Per 
modificare la trasparenza utilizzare la piccola 
iconcina scorrevole visibile sul logo del piano.

Suggerimento : Il  livello  di  trasparenza  può  anche  essere  modificato  in  valore 
percentuale dalla finestra delle proprietà.

Trucchi e suggerimenti

 In cima alla catasta c'è l'icona di un “occhio”che osserva la catasta. Cliccando l'occhio 
vengono nascosti tutti i piani con simboli grafici e rimangono visibili solo i piano con 
le immagini. Cliccando nuovamente i piani nascosti tornano visibili.

 I piani dei cataloghi posizionati in cima alla catasta vengono proiettati su tutti i piani 
delle  immagini  sottostanti.  In  caso  di  visualizzazioni  multiple,  è  spesso  utile 
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restringere  la  proiezione  di  certi  cataloghi  solo  su  alcune  immagini.  Questo  può 
essere  fatto  posizionando  il  piano  del  catalogo  nella  stessa  cartella  in  cui  c'è 
l'immagine su cui va proiettato. Successivamente, nella finestra delle proprietà della 
carella,  selezionare  se  la  proiezione  dei  piani  dei  cataloghi  della  cartella  avviene 
“locale”  (sulle  sole  immagini  contenute  nella  cartella)  o  “globale”  (su  tutte  le 
immagini della catasta). 

5.1.2 La visualizzazione

La finestra della visualizzazione è la parte fondamentale dell'interfaccia di Aladin. La 
visualizzazione mostra i dati contenuti nella catasta (in genere immagini con i simboli 
delle sorgenti dei cataloghi).  Sul bordo sono visualizzate ulteriori informazioni: scala, 
dimensioni del campo di vista, angolo rispetto al Nord.

15



Localizzazione degli oggetti

Per localizzare con precisione gli oggetti sull'immagine, Aladin sfrutta le informazioni 
della calibrazione astrometrica presenti nell'immagine stessa. 
La  maggior  parte  delle  immagini  hanno  la  propria  calibrazione  astrometrica  (in 
particolare quelle  in formato fits).  Se così non fosse (es.  lavorando con un'immagine 
JPEG fornita  dall'utente),  è  possibile  aggiungere  la calibrazione astrometrica  (menu: 
Immagine  => Calibrazione astrometrica  – see5.8). A volte gli oggetti non corrispondono 
perfettamente  con  l'immagine,  le  possibili  cause  sono  posizioni  approssimate  o  una 
calibrazione astrometrica non molto precisa.

Passare all'immagine successiva

Menu: Visualizza => Prossima immagine
Tastirea: Tab

Se la catasta ha numerose immagini, è possibile passare velocemente da una all'altra 
semplicemente  attivando  il  piano  corrispondente.  Automaticamente  saranno  attivati 
tutti i piani grafici (disegni e cataloghi) che possono essere sovrimpressi all'immagine. 
Il menu “Visualizza => Prossima immagine” o il tasto “TAB” fanno al stessa azione. Questo 
è particolarmente utile nelle modalità a schermo intero e anteprima (preview).

Cubi o “sequenze animate"

Nel caso di un'immagine “cubica”  (vedi  5.10 - associazioni o cubi FITS), il piano della 
catasta  contiene  numerose  immagini  che  saranno  visualizzate  come  una  sequenza 
animata,  con  un  ritardo  tra  un'immagine  e  l'altra  (400ms  di  default)  modificabile 
dall'utente  dalle  proprietà  del  piano.  L'animazione  è  controllabile  da  una  serie  di 
comandi standard (play, pausa, stop, avanti, indietro), visualizzati nella parte superiore 
dell'immagine. Sotto i comandi un righello visualizza la posizione dell'immagine attuale 
nel cubo, che può essere modificata con il mouse.

Trasparenza

Un'immagine  può  essere  visualizzata  semi-
trasparente  sopra  un'altra  immagine.  Questo  è 
particolarmente  utile  quando  l'immagine  da 
visualizzare in trasparenza è più piccola di quella 
di sfondo. Per attivare la trasparenza utilizzare il 
piccolo  righello  rosa  presente  nella  parte 
inferiore  del  logo  del  piano  dell'immagine. 
Quando il  righello  è  tutto  a  destra,  l'immagine 
collocata sopra nasconde completamente la parte 
corrispondente dell'immagine di sondo.  

Per cambiare l'immagine di sfondo modificare la disposizione dei piani nella catasta. 
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Reticolo

Menu: Sovrapponi => Reticolo…

Il reticolo permette di localizzare una particolare posizione. Solitamente viene indicata 
l'ultima posizione cliccata. Il reticolo è visualizzato come una piccola croce magenta o 
come due linee incrociate. E' anche possibile nasconderlo (menu sovrapponi => Nessun 
reticolo).
Le coordinate del reticolo appaiono nel campo “posizione”. Scrivendo qui le coordinate, 
o il nome di un oggetto, il reticolo si sposta sulla posizione corrispondente. 

I 3 strumenti per configurare la visualizzazione

L'azione svolta dal  mouse nella  finestra  di  visualizzazione dipende dallo  “strumento” 
selezionato. I 3 strumenti disponibili sono:
 Selezione: per selezionare gli oggetti visualizzati, incluse le sorgenti dei cataloghi
 Pan: per spostare il campo di vista;
 Zoom: per ingrandire o rimpicciolire la visualizzazione.

Di default è attivata la modalità “selezione”. Prima di utilizzarla con il mouse assicurarsi, 
guardando la barra degli strumenti, che il relativo pulsante sia evidenziato.

Suggerimento:  Spostando  il  mouse  fuori  dalla  finestra  di  visualizzazione  viene 
selezionata automaticamente la funzione “Selezione”.

Selezione degli oggetti  

Bottone: select  

Quando Aladin  visualizza  oggetti  grafici  (sorgenti  dei  cataloghi  o  altro),  in  modalità 
selezione  si  possono  selezionare  alcuni  di  questi  oggetti.  Per  attivare  la  modalità 
selezione cliccare  il  pulsante  “select”  nella  barra  degli  strumenti.   La  selezione degli 
oggetti avviene cliccando su di essi o creando un rettangolo di selezione che racchiude gli 
oggetti  desiderati.  Gli  oggetti  selezionati  sono  evidenziati  con  dei  piccoli  quadratini 
verdi.  Se  gli  oggetti  selezionati  sono  sorgenti  astronomiche,  allora  i  dati  relativi 
compaiono  nella finestra delle misurazioni  (vedi Errore: sorgente del riferimento non
trovata).

Gli  oggetti  selezionati,  se  sono  simboli  grafici  e  non  sorgenti  dei  cataloghi,  possono 
essere  spostati,  cliccando  e  spostando  i  quadratini  verdi  che  appaiono  durante  la 
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selezione.  Inoltre,  se tali  oggetti  sono i  campi di  vista degli  strumenti,   (vedi  5.2.6 - 
FoV),gli angoli possono essere utilizzati per la loro rotazione.

Muovere l'immagine  

Bottone: muovi   
Menu: Modifica => muovi…
Tastiera: Alt+Z
Mouse: Tasto centrale

E'  possibile  spostare  un immagine attivando lo  strumento “muovi”.  Successivamente 
cliccare sull'immagine e muoverla nella direzione desiderata. Per tornare alla modalità 
“selezione” portare il mouse fuori dalla finestra di visualizzazione o attivare lo strumento 
“selezione”.

Suggerimento: Utilizzare  il  tasto  centrale  del  mouse  per  muovere  l'immagine  anche 
mentre è attivata la modalità “selezione”.

Zoom  

Bottone: zoom  
Menu: Modifica => Zoom…
Tastiera: F7, F8 -  F6 
Mouse: rotella

Aladin permette di ingrandire o rimpicciolire rapidamente una parte di un'immagine. 
Sono permessi solo le potenze di due, da 1/2048 a 2048 ingrandimenti, con l'aggiunta di 
una fattore 2/3. Per fattori minori di ¼ Aladin utilizza un particolare algoritmo sui pixel 
vicini (immagini nitide). Tra ¼ e 2/3 Aladin utilizza la media, mentre tra 2 e 2048 i 
pixel vengono duplicati (“pixel grandi”).

Il fattore di zoom può essere modificato in molti modi:
 Utilizzando  il  bottone  “zoom”  e  cliccando  sulla  visualizzazione  (per  rimpicciolire 

tenere premuto il tasto shift). Per passare rapidamente alla modalità “select” portare 
il mouse fuori dalla visualizzazione.

 Utilizzando la rotella del mouse con il mouse posizionato sulla visualizzazione.
 Utilizzando il menu contestuale alla destra della finestra.
 Utilizzando il menu  “Edit => Zoom”

Se l'immagine ha una calibrazione astrometrica, con lo zoom l'immagine verrà ricentrata 
sulla attuale posizione del reticolo (a meno che la visualizzazione non venga bloccata – 
vedi  sotto).  E'  quindi  molto  semplice  ingrandire  un  particolare  oggetto:  spostare  il 
reticolo sull'oggetto (click del mouse) e poi utilizzare la rotella del mouse.

Griglia delle coordinate 

Icona: griglia   
Menu: Sovrapponi => Griglia
Tastiera: Alt+G
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la griglia delle coordinate può essere attivata con l'icona “griglia” situata sotto la finestra 
della visualizzazione o dal menu “Sovrapponi => Griglia”. La scala della griglia dipende 
dal fattore di zoom. Il sistema di riferimento della griglia delle coordinate è lo stesso 
utilizzato  per  definire  la  posizione  di  un  oggetto  con  il  mouse.  Non  è  possibile 
rappresentare contemporaneamente diverse griglie corrispondenti a differenti sistemi di 
coordinate.

Se il fattore di zoom è molto piccolo (1/512x), la griglia può apparire incompleta, nel 
caso  in  cui  la  soluzione  astrometrica  dell'immagine  sia  inaccurata  per  calcolare  una 
posizione molto lontano dall'immagine.

Freccia sull'oggetto 

Menu: Sovrapponi => Freccia sull'oggetto
Tastiera: Alt+T

Quando un'immagine viene richiesta inserendo le coordinate o il nome di 
un oggetto  (vedi  5.2 – selezione del  server),  una piccola  freccia  rossa 
indica la posizione nell'immagine. Questa freccia può essere cancellata 
dal menu “Sovrapponi => Freccia sull'oggetto”.

Visualizzazioni multiple

Per  paragonare  più  facilmente  molte 
immagini  può  essere  utile  creare  più 
visualizzazioni  contemporaneamente. 
Il pannello principale può essere diviso 
in 2, 4,  9 o 16 sotto-pannelli,  ognuno 
dei quali può visualizzare un'immagine 
diversa  e  simboli  grafici.  Queste 
immagini  possono  rappresentare  la 
stessa  regione  di  cielo  o  regioni 
differenti. E' anche possibile utilizzare 
più  pannelli  per  una  sola  immagine, 
per esempio per vedere vari dettagli. 

Numero di visualizzazioni

Icona: multiview   
Menu: Visualizza => N finestre
Tastiera: F1, Maj+F2, F2, F3, F4

La modifica del numero di finestre può essere fatta sia tramite le icone “visualizzazioni 
multiple” posizionate nell'angolo in basso a sinistra della finestra della visualizzazione, 
sia dal menu “Visualizza => 1, 2, 4, 9, o 16 finestre”. Se si utilizzano più visualizzazioni del 
numero di pannelli disponibili, una barra di scorrimento appare alla destra della finestra 
principale  e  permette  di  accedere  alle  altre  visualizzazioni.  Possono  essere  create 
migliaia di visualizzazioni  (see Errore: sorgente del riferimento non trovata – creare le 
anteprime). Solamente le visualizzazioni visibili utilizzano memoria RAM.
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Posizionamento delle visualizzazioni   
Il posizionamento di una immagine su una visualizzazione avviene trascinando il logo 
del  piano  corrispondente  sulla  visualizzazione.  E'  anche  possibile  creare  una 
visualizzazione per ogni immagine presente nella catasta utilizzando il menu  “Visualizza 
=> Crea una nuova visualizzazione per immagine". 
Trucco: E'  possibile  trascinare  immagini   JPEG,  PNG,  GIF,  FITS  direttamente  dal 
proprio pc (es. dal desktop o da un'altra cartella) e/o dal proprio browser web, nella 
visualizzazione di Aladin.

Visualizzazione corrente  
La  visualizzazione  corrente,  cioè  quella  a  cui  viene  applicato  l'operatore  di  zoom,  è 
evidenziata  con  un  contorno  blu.  Per  selezionare  una  visualizzazione  come 
visualizzazione corrente, cliccare su di essa. 
Tenendo  premuto  il  tasto  Maiusc  è  possibile  selezionare  più  visualizzazioni 
contemporaneamente, per esempio per selezionare le immagini da cancellare.
 
E'  possibile  vedere  la  visualizzazione  corrente  (riquadro  blu)  in  una  visualizzazione 
singola  selezionando  la  modalità  a  pannello  singolo.  Le  altre  visualizzazioni  non 
vengono  cancellate  e  rimangono  accessibili  sia  attraverso  la  barra  di  scorrimento 
verticale alla destra della finestra, sia riselezionando una visualizzazione multipla. 
La visualizzazione corrente può anche essere vista a schermo intero (menu “Visualizza 
=> schermo intero”) o in una singola finestra (menu “Visualizza => finestra semplice”).

Far corrispondere le visualizzazioni  

Icona: corr    
Menu: Visualizza   => Eguaglia...
Tastiera: Alt+S, Alt+Q
    

In  modalità  visualizzazione  multipla  è  possibile  far  corrispondere  la  scala  e  anche 
l'orientazione di differenti immagini della stessa regione di cielo. 
Queste funzioni sono accessibili rispettivamente dai menu “Visualizza => Eguaglia scala” 
e “Visualizza => Eguaglia sala e orientazione”
Nel secondo caso può anche essere utilizzato il bottone “corr”. Far corrispondere le scale 
non altera i  pixel,  semplicemente seleziona il  centro e il  fattore di zoom corretti  per 
visualizzare  la  medesima  regione  di  cielo.  Questo  non  avviene  quando  si  fanno 
corrispondere  sia  la  scala  che  l'orientazione,  poiché  Aladin  riproietta  le  immagini 
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utilizzando  la  posizione  dei  quattro  angoli:  le  immagini  sono  identiche  ma vengono 
ricampionate.  Le  due  visualizzazioni  vengono  automaticamente  selezionate  assieme 
(riquadro  blu).  Se  è  richiesta  anche  la  corrispondenza  dell'orientazione,  le  immagini 
vengono evidenziate con un contorno rosso.

Visualizzazione bloccata

Menu: Visualizza => Visualizzazione bloccata

Quando si esegue un doppio click su una visualizzazione, tutte le altre visualizzazioni 
relative  alla  medesima  regione  del  cielo  saranno  centrate  automaticamente  sulla 
posizione cliccata. La stessa cosa avviene se uno clicca sulle misure. Per evitare questa 
modifica  della  posizione  centrale  e/o  del  fattore  di  zoom,  è  possibile  bloccare  una 
visualizzazione in modo da farle tenere sempre lo stesso centro e lo stesso fattore di 
zoom.  (Menu  “Visualizzazione  => Visualizzazione  bloccata").  Quando  viene  bloccata  la 
visualizzazione appare un piccolo lucchetto rosso nell'angolo in basso a sinistra .

Panelli fissi
Menu:    Visualizza  => Visualizzazione bloccata

Per evitare lo spostamento di una o più visualizzazioni quando si 
usa la barra di scorrimento verticale, è possibile fissare il pannello 
per fargli mantenere la sua posizione . Utilizzare il menu “Visualizza 
=> visualizzazione bloccata ”. Il pannello su cui viene attivata questa 
funzione viene evidenziato con due triangoli rossi agli angoli e non 
è soggetto alla barra di scorrimento.

Muovere e incollare

E' facile spostare una visualizzazione da un pannello all'altro facendo un semplice “clicca 
e trascina” con il mouse. Se si tiene premuto il tasto Ctrl questa funzione crea una copia 
della visualizzazione. 

Cancellare
Cancellare una visualizzazione non significa cancellare le immagini e i cataloghi utilizzati 
per generarla. I dati rimangono accessibili nella catasta. Cancellare un'immagine dalla 
catasta invece elimina tutte le visualizzazioni che la utilizzano.  Il menu “Visualizza => 
Cancella  le  altre  visualizzazioni”  permette  di  cancellare  rapidamente  tutte  le 
visualizzazioni tranne quella corrente. 

Schermo intero e finestra semplice

Icona:  
Menu:             Vista => Schermo intero, finestra semplice
Tastiera: F11, F12

Una  visualizzazione  può  essere  vista  a  schermo  intero,  oppure  in  una  finestra  più 
semplice senza il resto dell'interfaccia grafica (menu, catasta, misure...). I tasti F11 e F12 
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permettono di  passare  rispettivamente  tra  queste  due modalità  di  visualizzazione.  Il 
tasto “Esc” permette di tornare alla visualizzazione originale. 

A  parte  per  le  dimensioni  della  finestra,  le  due  modalità  di  visualizzazione  sono 
identiche. L'uso di Aladin nelle modalità “schermo intero” e “finestra semplice” modifica 
l'uso normale del programma:
 sul  lato  destro  vengono  visualizzate  alcune  icone  che  permettono  di  attivare  o 

disattivare  i  cataloghi  e  le  sovrimpressioni  grafiche,  visualizzare  o  nascondere  la 
griglia delle coordinate, salvare la schermata corrente in PNG (o JPEG se viene 
premuto il tasto SHIFT – questo produce file di dimensioni minori ma meno 
definiti), passare al campo successivo (se esiste).

 L'icona   permette di tornare indietro alla modalità normale (come il  tasto 
“ESC")

 Informazioni sulla posizione e sul valore dei pixel sono sovrimposte nell'angolo 
in alto a destra dell'immagine.

 Il  mouse combina le  funzioni  “selezione”  e  “muovi”  (vedi  sezione successiva – la 
barra degli strumenti). E' possibile muovere il campo di vista cliccando e trascinando 
l'immagine. E' anche possibile selezionare un oggetto cliccando direttamente su di 
esso.

 Si  può  selezionare  una  sola  sorgente  alla  volta:  le  sue  informazioni  saranno 
sovrimpresse sull'immagine.  
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 Un  comando  di  script  può  essere  digitato  direttamente  nella  finestra,  verrà 
visualizzato sovrimpresso.

 Se la catasta è vuota, appare un semplice campo che permette di inserire il  nome di 
un oggetto o una posizione.

Suggerimento: La modalità “visualizzazione semplice” ha tutte le funzioni base di Aladin. 
Può essere utilizzata di default (see  8.1 –  profilo dell'utente) e, soprattutto, se Aladin è 
utilizzato come applet (vedi 7.2 – Aladin in un browser web)

5.1.3 La barra degli strumenti

Situata  verticalmente  tra  la  catasta  e  la  finestra  della  visualizzazione,  la  barra  degli 
strumenti permette un rapido accesso alle funzioni principali.

 selez Modalità seleziona
 muovi Modalità muovi
 zoom Modalità zoom
 dist Tracciare un vettore di distanza
 diseg Disegnare a mano
 segna Contrassegnare una posizione
 testo Aggiungere del testo
 filtro Creare un filtro su un catalogo
 corr Corrispondenza tra cataloghi
 rgb Creare un'immagine a colori
 anim Generare associazioni di immagini (mosaici o sequenze animate)
 cont Generare contorni
 lente Attivare/disattivare la lente d'ingrandimento
 pixel Modificare la distribuzione delle intensità dei pixel
 prop Finestra delle proprietà
 canc Cancella l'elemento corrente

Attivazione
Le varie funzioni sono attivabili  a seconda del piano selezionato nella catasta. Alcuni 
bottoni rimangono non evidenziati se non sono attivabili  sul piano selezionato o se il 
numero di piani selezionati non corrisponde all'azione richiesta. 

Modalità e strumenti
I  primi  tre  pulsanti  fanno riferimento  alle  funzioni  assegnate  al  mouse:  selezionare, 
muovere il  campo o zoomare. Questi  tre  pulsanti  si escludono uno con l'altro.  Come 
indicato precedentemente, quando il mouse viene portato fuori dall'immagine si attiva la 
funzione “selezione”.
Tutti gli altri pulsanti fanno riferimento agli strumenti. Qui descriviamo in dettaglio solo 
gli strumenti che non sono descritti in altre sezioni di questo manuale.

Strumenti grafici: dist, disegn, segna e testo 

Menu: Sovrapponi => dist, disegn, segna, testo

23



Tastiera: Alt+D (distanza)

I quattro pulsanti degli strumenti grafici per misurare 
la distanza, disegnare a mano, posizionare contrassegni 
e scrivere testo sono sempre attivabili. La scelta di uno 
di  questi  strumenti  porta  alla  creazione  di  un  piano 
“drawing”  in  cima  alla  catasta.  Gli  elementi  grafici 
aggiunti con il mouse sull'immagine corrente saranno 
memorizzati  in  questo  piano  con  le  loro  coordinate 
celesti, e quindi utilizzabili anche su altre immagini. 

Selezionare e muovere
Gli  elementi  grafici  creati  da uno di  questi  4  strumenti  possono essere  selezionati  e 
anche  spostati  cliccandoli  e  trascinandoli  con  il  mouse.  Quando vengono selezionati 
appaiono evidenziati con dei quadratini verdi.

Dettagli  tecnici: quando uno o più  elementi  vengono mossi  assieme lo  spostamento 
viene calcolato sulle coordinate celesti (AR, Dec) solo per l'oggetto sotto il puntatore del 
mouse, e poi esteso agli altri oggetti selezionati.
Tenendo premuto il tasto Shift vengono considerati per tutti gli oggetti solo i movimenti 
sulle coordinate XY. Le due tecniche danno risultati differenti, soprattutto quando gli 
oggetti da muovere sono distanti molti gradi o vicini ai poli.

Alcuni suggerimenti:
 Quando si inserisce un contrassegno (strumento “tag”) tenere premuto il tasto SHIFT 

porta  al  calcolo  del  centroide  dei  valori  delle  intensità  dei  pixel  più  vicini  alla 
posizione selezionata  e  sposta  il  contrassegno sul  centroide.   Questo  permette  di 
posizionare facilmente un contrassegno sul centro di una stella.

 E' possibile visualizzare accanto a un contrassegno le sue coordinate: selezionare il 
contrassegno  e,  dal  menu  contestuale  (click  destro)  “visualizza  coordinate  degli  
oggetti selezionati”

 Per disegnare a mano (strumento “disegn”) è possibile sia tenere premuto il bottone 
del mouse per disegnare in modo continuo, che cliccare più volte per disegnare linee 
rette  una  di  seguito  all'altra.  In  questo  secondo  caso,  per  fermare  il  processo  di 
disegno è necessario  portare  il  puntatore  del  mouse fuori  dalla  visualizzazione,  o 
cliccare due volte sull'ultimo punto.

 Per creare un nuovo piano, così che gli elementi grafici  siano su un piano a sé, tenere 
premuto SHIFT mentre si attiva lo strumento.

Profilo  dell'intensità  dei  pixel  associati  a  un 
vettore di distanza  

Quando  nella  visualizzazione  viene  selezionato 
un vettore di distanza, nella finestra dello zoom 
(pannello  in  basso  a  destra)  appare  il  profilo 
dell'intensità  dei  pixel  lungo  il  vettore  di 
distanza. 
Se  il  vettore  di  distanza  viene  spostato  nella 
finestra, il profilo evolve in funzione della posizione del vettore sull'immagine.
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Inoltre, muovendo il mouse sul profilo appare una linea rossa orizzontale che fornisce la 
distanza angolare e il numero di pixel del picco sottostante. Questo metodo è utile per 
esempio per ottenere una veloce approssimazione della larghezza a metà altezza di una 
stella. 

Per un'immagine in colori reali (vedi  8.2 – tipi di dati supportati), i livelli di ciascuna 
componente Rosso/Verde/Blu sono visualizzati simultaneamente. 

Profondità associata allo strumento contrassegno
La posizione e selezione di un contrassegno (con lo strumento “Tag") in un'immagine 
cubica genera anche un profilo di profondità. Nel grafico così ottenuto la linea rossa 
verticale corrisponde alla posizione dell'immagine corrente nel cubo (in Aladin un cubo 
è interpretato come una sequenza di immagini).  Il valore riportato sotto questa linea 
fornisce la scala fisica corrispondente all'immagine attuale nel cubo (per es. la velocità). 
Come  per  lo  strumento  distanza,  muovere  il  contrassegno  con  il  mouse  causa  il 
ricampionamento automatico del grafico. 
Muovendosi  con  il  mouse  sul  grafico  restituisce  il  valore  del  pixel  corrispondente 
(coordinate  nel  grafico).  Un click  con successivo  trascinamento  orizzontale  sposta  la 
linea rossa oltre l'immagine corrente e quindi cambia l'immagine visualizzata.

Misurazioni di fotometria con gli strumenti “segna” and "disegna"

Se  gli  strumenti  "segna”  e  "disegna”  sono  utilizzati  per  definire  un'area  (cliccare  e 
trascinare  con “segna”  per  definire  un cerchio,  creare  linee  chiuse  con “disegna”)  si 
possono ottenere 5 differenti misurazioni per i pixel racchiusi nell'area: la somma, la 
media, la mediana, il sigma e la superficie. Questi valori sono visualizzati direttamente 
sulla  finestra  principale.  Zoomare  su  quest'area  evidenzia  i  pixel  interessati  con  dei 
piccoli quadratini.
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Lo strumento “lente di ingrandimento“

Icona: lente
Menu: Immagine =>Lente di Ingrandimento
Tastiera: Ctrl+G

Quando viene attivata la lente di ingrandimento la finestra dello 
zoom (in basso a destra) viene utilizzata per vedere lo zoom dei 
pixel attorno al puntatore del mouse mentre esso si muove nella 
finestra. 
Usando  le  frecce  (su,  giù,  destra,  sinistra)  è  quindi  possibile 
spostare il puntatore del mouse di pixel in pixel.

Utilizzando  i  tasti  “+”  e  ”-”  si  può 
aumentare  e  diminuire  il  fattore  di 
ingrandimento della lente.

 I  valori  delle  intensità  dei  pixel  saranno  visualizzati  sui  pixel 
stessi se le loro dimensioni sono sufficientemente grandi.

Lo strumento “canc”

Icona: Canc
Menu: Modifica  => Cancella

Modifica  => Cancella tutto
Tastiera: Canc o  SHIFT+Canc

Lo  strumento  “canc”  svolge  azioni  diverse  a  seconda  del  contesto.  A  seconda 
dell'elemento/i selezionati con il mouse, saranno cancellati:
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 Gli elementi grafici;
 Le visualizzazioni;
 Il piano/i piani.

Inoltre, premendo contemporaneamente il tasto “SHIFT”, saranno cancellati tutti i dati 
caricati in Aladin. Usare con attenzione,  in Aladin non c'è la funzione “annulla”.

Gli  altri  strumenti accessibili  dalla  barra degli  strumenti  saranno descritti  nelle  altre 
sezioni di questo manuale.

5.1.4 Il pannello dello zoom

Il  pannello  dello  zoom  è  posizionato  in  basso  a  destra  della  finestra  principale. 
Rappresenta  un'illustrazione  dell'intera  immagine  a  cui  è  sovrapposto  un  rettangolo 

trasparente  blu.  Il  rettangolo  corrisponde  alla  parte 
dell'immagine mostrata  nella  visualizzazione.  Aiuta l'utente a 
orientarsi rispetto sull'immagine intera.

Il  rettangolo  può  essere  spostato  con  il  mouse.  La 
visualizzazione cambia automaticamente  sulla  corrispondente 
porzione dell'immagine. 
Se la regione visibile è completamente fuori dall'immagine, una 
freccia rossa indica la direzione da seguire.

Le informazioni sovrimpresse indicano le dimensioni angolari dell'intera immagine.

Il fattore di  zoom può essere modificato facilmente utilizzando la rotella del mouse. Per 
centrare  la  visualizzazione  nelle  sue  massime dimensioni,  cliccare  sul  pannello  dello 
zoom tenendo premuto il bottone “CTRL”.

5.1.5 Campi della posizione

Sopra  la  finestra  principale,  appena sotto  il  menu,  due campi  indicano  la  posizione 
corrente  e il valore dell'intensità dei pixel indicati dal puntatore del mouse,. Ciascuna di 
queste  informazioni  può  essere  espressa  in  uno  specifico  sistema  di  riferimento 
selezionabile nel menu a tendina situato alla destra di ciascuno dei due campi.

Posizione

La  posizione  può  essere  espressa  in  coordinate  celesti  o  in  coordinate  cartesiane 
(ascissa/ordinata) dell'immagine. Le coordinate celesti disponibili sono: ICRS, J2000, 
B1950,  Eclittiche,  Galattiche,  Supergalattiche,  sia  nel  sistema  decimale  che 
sessagesimale. L'accuratezza della posizione dipende dal fattore di zoom.
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Valore dei pixel

Il valore dell'intensità dei pixel può essere dato in tre modi diversi:
 8 bits: il livello “un solo colore” (in genere grigio) restituisce un valore tra 0 e 255 che 

dipende principalmente da come è impostato il contrasto. Se l'immagine è in JPEG è 
disponibile solo questa modalità di visualizzazione;

 File raw: il valore utilizzato per codificare i pixel nel file dell'immagine;
 Full: il valore “fisico” del pixel. Questo valore è dato dal valore codificato nel file raw 

riscalato per un valore fornito dall'immagine (BSCALE – in accordo con il formato 
FITS)  e  per  la  distanza  dall'origine  (BZERO).  Questo ultimo valore  (full)  è  il  più 
significante ed è quello dato di default (Full=raw*BSCALE+BZERO). Se i parametri 
BSCALE e BZERO non sono disponibili, il valore “full” di un dato pixel corrisponde 
con il suo valore “Raw”.

Salvare le informazioni correnti

I  valori  nei  campi  della  posizione  e  dei  pixel  vengono  modificati  continuamente 
seguendo il movimento del mouse. Comunque, un click del mouse nella visualizzazione 
permette di salvare i valori correnti (posizione + pixel) e questi valori appaiono per un 
istante di colore rosa.
Questi valori saranno salvati nei campi “posizione” e ”pixel” e verranno visualizzati al 
passaggio  del  mouse  nei  due  campi.  Possono  così  essere  copiati  e  incollati  in  altre 
applicazioni.

Inserire la posizione o il nome di un oggetto

Menu: strumenti => Ricerca nome dell'oggetto …
Tastiera: Ctrl+R

E' possibile  indicare una posizione direttamente nel campo “posizione”. Il  sistema di 
riferimento deve corrispondere a quello specificato nel menu  a tendina (J2000, B1950d, 
Xyimage…). Premendo il tasto “Invio” il reticolo (la croce rosa) si sposta sulla posizione 
indicata e la visualizzazione viene centrata sulla stessa posizione.  Questa posizione può 
anche essere al di fuori dell'immagine.

E'  anche  possibile  inserire  direttamente  il  nome  di  un  oggetto.  In  questo  caso  la 
convalida con il tasto “Invio” porta prima a una quesry al servizio “CDS Sesame” che 
ritorna la migliore posizione conosciuta per l'oggetto, cercando nei database SIMNAD o 
NED  e  in  alcuni  cataloghi  astronomici  in  Vizier.  Successivamente,  utilizzando  le 
coordinate così ottenute, Aladin sposta il reticolo e centra la visualizzazione sulla nuova 
posizione.  Questa  funzione  è  anche  accessibile  dal  menu  “Strumenti  => ricerca  nome 
dell'oggetto”.

Suggerimento: se la visualizzazione è ancora vuota, scrivere delle coordinate o il n0me 
di un oggetto creerà automaticamente tre piani con l'immagine DSS, SIMBAD e NED.
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Comandi di script   
Il  campo della posizione può anche essere utilizzato  per digitare  i  comandi di script 
(vedi 7.1 – script in Aladin).

.

5.1.6 Finestra dei dati

Il “pannello dei dati” è posizionato sotto la finestra principale di Aladin. Viene utilizzato 
per visualizzare i dati associati alle sorgenti. E' uno strumento potente che permette di 
selezionare, ordinare e filtrare le tabelle. 

Nel pannello dei dati appaiono solo le sorgenti selezionate (la selezione è ottenuta con il 
mouse). Questi dati sono elencati  in una tabella in cui ciascuna riga contiene i valori 
associati a una sorgente.

Le sorgenti selezionate sono contrassegnate da un quadratino verde. Quando il mouse 
viene portato su una di esse la sorgente lampeggia e nella tabella viene evidenziata in blu 
la  riga  corrispondente.  Viceversa,  posizionandosi  su  una  riga  della  tabella,  viene 
evidenziata la sorgente corrispondente, se visibile. Inoltre, cliccando due volte su una 
riga della tabella la visualizzazione viene centrata sulla sorgente corrispondente.

La prima riga della tabella descrive il contenuto di ciascuna colonna. Cliccando su una 
cella della prima riga i  dati  della colonna corrispondente verranno ordinati  prima in 
ordine crescente e poi decrescente.  A lato del nome della colonna appare un piccolo 
triangolo per indicare la colonna ordinata. L'ordinamento può essere sia alfabetico che 
numerico, a seconda del contenuto della colonna. 
E'  possibile  modificare  la  larghezza  di  una  colonna  trascinando  il  bordo  della  cella 
dell'intestazione.  Se  una  cella  è  troppo  piccola  per   visualizzare  l'intero  valore, 
passandoci sopra con il mouse si vedrà la cella momentaneamente più larga con l'intero 
valore.
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Dati da cataloghi differenti

Se le sorgenti selezionate provengono da cataloghi diversi, tabelle con colonne diverse 
saranno elencate una dopo l'altra. Il colore del quadratino all'inizio della riga è utile per 
distinguere le tabelle (il colore è lo stesso del piano del catalogo nella catasta).

La  riga  evidenziata  è  l'ultima  selezionata  (cliccata  con  il  mouse)  oppure  quella 
corrispondente alla sorgente su cui è posizionato il mouse.

Collegamenti e pulsanti 

Come  nei  browser  web,  i  dati  sottolineati  blu  sono  collegamenti  a  informazioni 
aggiuntive disponibili sul web. Quando il mouse passa sul collegamento l'indirizzo web 
corrispondente è visualizzato sotto la finestra principale di Aladin.  

Cliccando un collegamento viene aperta la pagina nel browser web. In generale, la prima 
cella di ogni riga è collegata alla pagina del catalogo in cui sono contenuti i dati.

Alcune celle hanno l'aspetto di un bottone. Come per i collegamenti web, cliccando uno 
di questi pulsanti si accede a informazioni aggiuntive disponibili sul web. Comunque, 
invece che mostrare  i  dati  sul  browser web,  i  dati  così  caricati  saranno aggiunti  alla 
catasta  per  essere subito  visualizzati  in Aladin.  Spesso  questi  dati  sono immagini  di 
archivio associate  a una lista di osservazioni.

Finestra indipendente

Il pannello dei dati può essere staccato dalla finestra principale cliccando sul logo in alto 
a destra  . Questo è utile sia per avere un maggiore spazio lavorativo, ma anche per 
lavorare più agevolmente con un elevato numero di dati.
Notare che nelle tabelle dei dati in Aladin possono essere facilmente caricare centinaia 
di migliaia di righe. Il pannello dei dati può essere reinserito nella finestra principale 
cliccando sullo stesso logo che lo ha separato o chiudendo il pannello stesso.

Selezione delle sorgenti

Le sorgenti possono essere selezionate dai menu, con il mouse, o con un'espressione di 
ricerca. 

Selezione dai menu
Menu: Modifica => Seleziona …
Tastiera: Ctrl+A (tutti gli oggetti)
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Il menu “modifica” ha un sotto menu che permette di selezionate tutte le sorgenti, cioè 
tutte le sorgenti presenti in tutti i  piani dei cataloghi caricati nella catasta. 
E'  anche  possibile  selezionare  solo  le  sorgenti  di  un  solo  piano,  attraverso  il  menu 
“Modifica => seleziona tutte le sorgenti dei piani selezionati”.

Selezione con il mouse
La  selezione  con  il  mouse  è  il  metodo  più  usato.  Permette  all'utente  di  scegliere  le 
sorgenti a seconda della loro posizione nella visualizzazione.
 Per selezionare una sorgente cliccare su di essa nella visualizzazione
 Per selezionare più sorgenti il  metodo più semplice è includerle in un rettangolo: 

cliccare su un punto “vuoto” in alto a sinistra della prima sorgente da selezionare e 
poi trascinare il puntatore del mouse in basso a destra, Durante questa operazione 
un rettangolo mostra la zona selezionata nella visualizzazione. Quando si rilascia il 
bottone del mouse vengono selezionate tutte le sorgenti all'interno del rettangolo.

 Per aggiungere sorgenti  a una selezione precedente, ripetere i passi descritti sopra 
tenendo premuto il tasto “SHIFT”.

Selezione tramite espressione  
Menu:             Modifica=> Cerca nei cataloghi caricati …
Tastiera: Ctrl+F

Aladin  fornisce  degli  strumenti  molto  efficaci  per  selezionare  le  sorgenti  di  cui  si 
conoscono i dati. Per fare questo è necessario caricare un catalogo r successivamente 
inserire un'espressione di ricerca nel campo “cerca” situato a sinistra sopra il pannello 
dei dati. 

Confermando la ricerca,  premendo “invio” sulla tastiera  oppure cliccando sul  piccolo 
pulsante  “Go”,  vengono  selezionate  tutte  le  sorgenti  le  cui  misure  corrispondono 
all'espressione di ricerca. 
La ricerca interesserà soltanto le sorgenti dei cataloghi dei piani attivati. Se l'espressione 
di ricerca è preceduta dal segno ‘+’, le nuove sorgenti selezionate saranno aggiunte alla 
selezione corrente. Oppure, inserendo il segno ‘-‘ davanti all'espressione di ricerca,  le 
relative  sorgenti  saranno  deselezionate  dalla  selezione  precedente,  esse  cioè 
scompariranno dalla tabella dei dati.

L'espressione di ricerca segue una sintassi semplice ed efficiente:
Si possono utilizzare
 Una serie di caratteri;
 Punteggiatur: ? e *;
 Nomi di colonna od  operatore di testo (=, !=, <, >, <=, >=) per restringere la ricerca 

a una particolare colonna;
Inoltre:
 Il nome della colonna può includere ? o *;
 Il nome della colonna può essere compresa tra due barre verticali ‘|’ per indicare il 

valore assoluto;
 Non c'è distinzione tra maiuscole e minuscole, sia per il nome della colonna che per i 

valori.
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Commento: 
la ricerca con una semplice catena di testo senza nessuna particolare indicazione sulle 
colonne viene sempre considerata come una sotto ricerca. Per esempio, la ricerca “gal” 
corrisponde in realtà a *gal*”.

Alcuni esempi:
 Star sorgenti i cui dati contengono la parola “star”
 otype=uv sorgenti la cui colonna “otype” ha il valore “uv”
 mag*>=12 prima  colonna  il  cui  nome  inizia  con  “mag”,  il  valore  numerico 

dovrebbe essere maggiore o uguale a 12
 |pm*|<5 come sopra ma ora è preso in considerazione  solo il valore assoluto;
 type!=g* colonna “type” i cui valori non iniziano con la lettera ‘g’
 bmag!="" colonna “bmag” non vuota

Deselezionare
Menu: Modifica=> Deseleziona oggetti …
Tastiera: Ctrl+U

 Per deselezionare una sorgente da una precedente selezione, cliccare sulla sorgente 
corrispondente tenendo premuto il tasto shift..

 Per deselezionare tutte le sorgenti, per es. svuotare la tabella dei dati, cliccare  in un 
punto qualsiasi lontano da una sorgente o utilizzare il menu “Modifica => deseleziona 
tutte le sorgenti”.

Suggerimento: Per non rischiare di perdere accidentalmente una selezione, cliccare le 
sorgenti nella tabella in modo che possano essere riselezionate successivamente (vedere 
la sezione seguente).

Contatori

Il numero di sorgenti selezionate (cioè quelle visualizzate) diviso per il numero totale 
delle sorgenti è dato dal contatore in basso a destra della finestra di Aladin:

Esplorare i dati

Esplorare i dati e soprattutto vedere rapidamente le sorgenti associate è possibile grazie 
alla selezione della specifica riga nella tabella dei dati. 
La riga selezionata appare evidenziata di blu anche se il mouse non è posizionato su di 
essa.

Una riga di dati può essere selezionata manualmente o tramite un'espressione di ricerca.
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Selezionare una riga di dati con il mouse

La selezione con il mouse può essere fatta sia nel pannello dei dati con un semplice click 
(al di fuori dei link e dei bottoni), o nel pannello della visualizzazione cliccando su una 
delle sorgenti selezionate (quadratini verdi). Questo porta allo spostamento del reticolo 
(croce magenta) sulla sorgente corrispondente.
Se la selezione è stata fatta attraverso la tabella con un doppio click, la visualizzazione 
viene automaticamente centrata sulla sorgente.

Ricorda: per  tornare  ad avere  una visualizzazione  globale,  utilizzare   Ctrl+  click  nel 
pannello dello zoom..

Selezionare una ruiga di dati tramite un'espressione  
Il  campo utilizzato  per selezionare  le  sorgenti  è  anche utilizzato  per selezionare  una 
specifica riga di dati.  Quindi,  scrivendo un'espressione –  SENZA confermarla (ne 
Invio ne “Go”) - e utilizzando le due frecce sulla destra del campo viene selezionata la 
riga precedente/successiva rispetto a quella indicata dall'espressione. 

Anche le frecce” su” e “giù” sulla tastiera e la rotella del mouse permettono di scorrere 
tra le righe di dati. Se l'espressione è vuota allora verrà semplicemente selezionate la riga 
precedente/successiva.

Deselezione
La deselezione della riga avviene con un semplice click del mouse nel pannello dei dati 
(fuori dai link e dai bottoni).

Commenti
Quando viene selezionata una riga di dati alcune azioni avvengono in automatico:
 L'intestazione del pannello dei dati rimane quella associata con la riga selezionata, 

anche se il mouse viene mosso al di fuori della riga corrispondente (questo permette 
di effettuare un ordinamento della tabella) 

 Spostandosi con il mouse sulle altre sorgenti della visualizzazione non evidenzia più i 
dati associati.

Controllare i dati 

Menu: Modifica => Seleziona …, Deseleziona…
Menu contestuale: Seleziona…, Deseleziona…, Prendi…

Alla  sinistra  della  riga  di  dati  c'è  un  piccolo  quadratino 
colorato, il cui colore è collegato all'origine dei dati. La riga e le 
sorgenti  corrispondenti  possono  essere  contrassegnate 
spuntando  il  quadratino  così  da  poter  essere  facilmente 
ritrovate in seguito.

Due menu permettono di configurare le sorgenti contrassegnate:
 Il menu contestuale appare direttamente nel pannello dei dati (click destro o click + 

CTRL):
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 Il menu principale  “Modifica ’:

Nella  visualizzazione,  le  sorgenti  di  cui  sono  state  contrassegnate  le  righe  di  dati 
appaiono con dei quadratini magenta invece che verdi. 

Aggiungere e calcolare una nuova colonna

Aladin offre la possibilità di aggiungere una nuova colonna di dati. Questa operazione 
viene descritta con maggiori dettagli nella sezione  5.7.

Esportare i dati

Menu: catalogo => Crea un nuovo piano con…
Menu contestuale: Crea un nuovo piano con …

I  dati  possono  essere  facilmente  copiati  negli  appunti  per  poi  incollarli  in  altre 
applicazioni. Il menu contestuale offre numerose possibilità:

E'  anche  possibile  generare,  attraverso  il  menu contestuale,  un nuovo piano con un 
catalogo che contiene una copia dei dati o delle sorgenti del pannello dei dati “Crea un 
nuovo pino con le sorgenti selezionate”  o nel menu principale “Menu  => Crea un nuovo 
piano con le sorgenti selezionate”.

Dopo aver descritto le funzionalità offerte dalla finestra principale di Aladi, passiamo 
alla finestra di selezione del server.

5.2 La finestra di selezione del server 
Icona: .
Menu: File=> Apri…, File => Carica …
Tastiera: Ctrl+O

La finestra di "selezione del server” permette di conoscere e consultare i diversi database 
astronomici accessibili tramite Aladin.
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Può essere aperta sia con l'icona   , in alto a sinistra, o da uno dei menu per caricare i 
dati  (menu “File”…)

La finestra appare come due serie di schede, una a sinistra e una a destra. Le schede 
nella parte sinistra della finestra sono correlate ai server delle immagini, le schede sulla 
destra ai server dei database, inclusi i cataloghi astronomici e l'elenco delle osservazioni 
dei telescopi. Infine, le schede in alto fanno riferimento a delle funzioni particolari che 
saranno descritte alla fine di questa sessione.

Schede  e  moduli  possono  evolvere  nel  tempo  e  a  seguito  di  nuove  aggiunte  della 
comunità  astronomica.  Ogni  volta  che  viene  attivato,  Aladin  accede  a  delle  “pagine 
gialle” dei servizi astronomici, per essere sempre aggiornato. 

5.2.1 Elenco dei server

E' possibile trovare in Aladin la maggior parte degli archivi astronomici del mondo, se 
distribuiscono i loro dati tramite internet.
Notare che certi dati sono distribuiti da più istituti ed è possibile accedere a essi tramite 
server differenti (p.es. il DSS è distribuito da 3 server). La lista dei server è descritta in 
dettaglio  nelle  FAQ  di  Aladin  al  seguente  indirizzo:  http://aladin.u-
strasbg.fr/java/FAQ.html#data
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5.2.2 Specificare le informazioni

La maggior parte dei moduli richiede almeno due informazioni per iniziare la ricerca: 
oggetto e raggio.

Specificare l'oggetto

L'oggetto può essere sia il  nome di  un oggetto astronomico riconosciuto  dal  sistema 
SESAME (ricerca in Simbad + NED + alcuni altri grandi cataloghi), sia le sue coordinate 
astronomiche J2000.

Alcuni esempi:
M1
NGC2045
Galactic centre
2 31 59 +89 15 54
12:59:48.70 +27:58:50.0

Specificare il raggio

Il raggio corrisponde al raggio del cono di ricerca in cielo. Il valore del raggio può essere 
seguito da una unità di misura (“°”, “' ““"“ or “deg”, “arcmin”, “arcsec”). L'unità di default 
sono  arcosecondi.  E'  anche  possibile  indicare  un'area  rettangolare  utilizzando  la 
seguente sintassi:  W x H dove W è la larghezza el rettangolo in ascensione retta e H 
l'altezza  del  rettangolo  in  declinazione.  Entrambi  i  valori  possono  essere  seguiti 
dall'unità di misura. 

Alcuni esempi
14
9.14’
20arcmin
10’ x 12’
1°

Selezione automatica

Nella  finestra  di  selezione  del  server  l''oggetto  e  il  raggio  vengono  riportati 
automaticamente  in funzione dei dati  caricati  precedentemente,  per coprire la  stessa 
regione di cielo. E' anche possibile selezionare esplicitamente una regione di cielo da una 
delle immagini caricate utilizzando il bottone   “prendi” che appare a fianco del campo 
posizione.  Facendo  così,  Aladin  chiederà  di  selezionare  la  regione  cliccando  e 
trascinandola nella visualizzazione.

Quando si passa da un modulo all'altro, nella finestra di selezione del server, tramite le 
schede, i valori indicati nel primo modulo sono mantenuti nei seguenti. 
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5.2.3Elenco e albero dei dati

Alcuni server necessitano di due passaggi per caricare i dati: prima va indicata la regione 
di  cielo,  successivamente  si  selezionano  i  cataloghi  o  i  dati  da  caricare  tra  quelli 
disponibili per quella regione. 
Nel secondo passaggio Aladin visualizza i 
dati  come  un  elenco  o  una  tabella. 
Questo  elenco/tabella  ha  varie 
funzionalità:
 Muovendo il mouse su un elemento, il 

corrispondente  campo  di  vista  sarà 
visualizzato sulla finestra principale.

 Se i dati sono visualizzati sotto forma di albero, un click con il pulsante destro apre 
un menu di controllo dell'albero.

 Se i dati sono visualizzati sotto forma di elenco, possono essere ordinati cliccando 
sull'intestazione delle colonne.

 Un click su un elemento visualizza le informazioni relative a quei dati, assieme ad 
alcuni parametri di ricerca.

 Ogni elemento è preceduto da un quadratino che permette di selezionare gli elementi 
da caricare. 

 In  alcuni  casi  la  selezione  può  essere  fatta  manualmente  o  cliccando  nella 
visualizzazione per selezionare gli elementi che contengono la posizione cliccata.

 Il  pulsante  Reset  permette  di  deselezionare  tutto.  Il  pulsante  Cancella  cancella 
l'elenco o l'albero. 

5.2.4 Cronologia delle ricerche 

Menu: File => Cronologia …
Tastiera: Ctrl+H

Durate la sessione, Aladin salva tutte le informazioni provenienti dai vari server dei dati 
interpellati.
Per fare questo viene creato un albero in cui i rami rappresentano i vari oggetti visitati 
durante la sessione, con un “innesto” per i risultati intermedi. 
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5.2.5 La barra di controllo

La finestra di selezione del server presenta nella parte inferiore un gruppo di pulsanti 
comuni a tutte le schede.

 Reset:  Cancella tutti i campi di selezione della scheda corrente;
 Cancella tutto: Reinizializza la scheda corrente riportando i campi al loro valore di 

default,  in  particolare  riporta  il  raggio  e  l'oggetto  a  quelli  dei  dati  caricati 
precedentemente;

 Aiuto: Visualizza un pannello di aiuto;
 INOLTRA: Inizia la ricerca;
 CHIUDI: Chiude la finestra.

5.2.6 Le 4 sezioni della finestra di selezione del server

Alcune schede speciali sono raggruppate nella parte superiore della finestra di selezione 
del server.

“File” - File o URL 

Questa scheda permette di caricare dati personali (qualsiasi tipo di file supportato da 
Aladin), attraverso file locali o indirizzi web. Il pulsante “Esplora” permette di esplorare 
il proprio PC per selezionare il file fa caricare. 

Suggerimento:  Dati  locali  possono  essere  caricati  anche  trascinando  l'icona  del  file 
direttamente all'interno della finestra di Aladin. La stessa cosa può essere eseguita con 
immagini o link visualizzati in un browser web.
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Suggerimento: Quando lavora con un file locale, Aladin esplora tutto il contenuto della 
cartella  e  delle  sottocartelle  e  crea  un  indice  dei  dati  disponibili  scrivendo  un  file 
“.aladin_idha” che sarà utilizzato la volta successiva per ricaricare più velocemente il 
contenuto.

“All VO” –Tutto il VO in un click! 

Questa  scheda  permette  di 
interrogare  tutti  i  server 
riconosciuti  da  Aladin,  non 
solo  quelli  visualizzati  nella 
parte  sinistra  e  destra  delle 
finestra  di  selezione  del 
server, ma anche tutti gli altri 
contenuti nelle “pagine gialle” 
dell'Osservatorio Virtuale.
La ricerca può essere ristretta 
a  server  di  immagini, 
cataloghi o spettri,

Il pulsante “lista dettagliata” 
permette di affinare la ricerca 
selezionando o deselzionando 
manualmente  i  server.  Il 
risultato  viene  visualizzato 
come albero di dati.

“FOV” - I campi degli strumenti 

Questa scheda permette di visualizzare i campi di vista (field of view - FOV) di un gran 
numero di telescopi. Questi campi di vista vengono sovraimposti sulle immagini per, ad 
esempio,  programmare  una  sessione  osservativa.  Possono  essere  spostati,   attivati  e 
disattivati con il mouse.
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E' anche possibili definire il proprio campo di vista tramite un file XML. La sintassi è 
disponibile su http://aladin.u-strasbg.fr/java/FAQ.htx#FoV.

“SExtractor “ - Individuazione delle sorgenti 

Questa  scheda  dà  accesso  allo  strumento  “SExtractor”  (Bertin  &  Arnouts,  1996  - 
http://terapix.iap.fr/) che permette  di  estrarre  un catalogo di sorgenti  dall'immagine 
corrente. 

5.2.7  Caratteristiche della scheda “Aladin Images” 

La scheda “Aladin images” permette di accedere alle immagini indicizzate al 
CDS (Strasburgo,  Francia)  per Aladin.  Qui,  tra  le  altre,  ci  sono immagini 
DSS,  2MASS,  DENIS,  IRAS-IRIS,  WENS.  Una  delle  caratteristiche  del  server  delle 
immagini di Aldin è di poter fornire immagini monocromatiche e calibrate in formato 
JPEG, se la velocità della propria rete è bassa. Un'altra funzione utile è che quando la 
lista  di  immagini  è  presentata  come  tabella,  le  immagini  possono  essere  ordinate 
cliccando sull'intestazione delle colonne. 

5.2.8 Caratteristiche della scheda “VizieR”

Il server VizieR dà accesso a quasi tutti i cataloghi astronomici (alcune migliaia). 
Possono essere semplici tabelle pubblicate nella letteratura scientifica, oppure 
cataloghi creati da grandi survey, alcuni contengono miliardi di oggetti. Possono 
anche essere rapporti di missioni, ovvero puntamenti storici dei maggiori telescopi. Per 
semplificare l'utilizzo di VizieR, Aladin ha 3 schede:
 “All Vizier ’: un modulo generico per accedere a qualsiasi catalogo;
 “ Surveys ’: un modulo dedicato alle grandi survey;
 “Missions ’: un modulo dedicato agli elenchi di osservazioni.
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All Vizier – Tutti i cataloghi Vizier

Il modulo generale (“All VizieR”) permette di inserire direttamente il nome o il numero 
del catalogo (nomenclatura CDS/ADC) nel campo specifico, oppure ottenere una lista di 
cataloghi che soddisfano alcuni criteri (testo, autori, lunghezza d'onda, missione o parole 
chiave). Questa ricerca può essere ristretta specificando un cono di ricerca nel campo 
“Target/Radius”. Questa funzione è utile per trovare tutti i cataloghi che hanno almeno 
un'osservazione  nel  campo specificato.  Successivamente  è  possibile  selezionare  nella 
lista i cataloghi di cui si vogliono visualizzare le sorgenti e poi cliccare “inoltra”.
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“Surveys“e “Missioni”

Le altre due schede dedicate a VizieR mostrano, per convenienza, da un lato le maggiori 
surveys e dall'altro le liste di osservazioni, disponibili in VizieR. Questi cataloghi sono 
presentati sotto forma di una tabella cliccabile..

"Tutte le colonne“ e "tutto il catalogo"

Alcune schede di VizieR hanno due quadratini selezionabili. Il primo permette di 
scaricare tutte le colonne del catalogo corrispondente -  e non solo quelle di default. Il 
secondo permette di scaricare l'intero catalogo senza tenere in considerazione un 
oggetto specifico. Quest'ultima opzione è limitata al primo milione di sorgenti.

5.2.9 Caratteristiche del modulo SkyBot

“SkyBot” apre una scheda per accedere agli oggetti del sistema solare (eccetto 
i pianeti). L'istituto di meccanica celeste di Parigi (IMCCE) ha permesso ad 
Aladin di accedere al proprio database di effemeridi per trovare asteroidi e altri corpi del 
sistema solare presenti nella propria immagine data l'epoca dell'osservazione.
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Il campo con la data viene completato automaticamente.

Nota: L'epoca presente nell'intestazione dell'immagine non è sempre precisa, causando 
possibili errori di posizione. In questo caso l'epoca può essere inserita a mano.

Inoltre,  è  possibile  inserire nel  campo dell'oggetto,  il  nome di un asteroide o di una 
cometa  in modo che SkyBot cerchi le sua posizione nell'epoca indicata, Per fare ciò, 
premere il pulsante “Get coord. for this object+epoch…”.

5.2.10 Aggiungere un server personale

La finestra di selezione del server può essere adattata alle proprie esigenze. E' possibile 
aggiungere un server personale che appaia come una ulteriore scheda. Per far ciò creare 
un file che contenga le informazioni quali il nome, l'indirizzo web e alcuni parametri e 
poi riavviare Aladin da riga di comando includendo il nome del file::

java –jar Aladin.jar –glufile=yourFile

Esempio di un file:  
%ActionName MyServer
%Aladin.Label Test
%Description This is an example of a server
%URL  http://my.web.site /my/base/query?yy=$1&xx=$2
%Param.Description $1=Parameter 1
%Param.Description $2=Parameter 2
%ResultDataType Mime(image/fits)

L'intera  sintassi  è  descritta  nelle  FAQ  di  Aladin  (http://aladin.u-
strasbg.fr/java/FAQ.html#Glu). 

Ora che abbiamo descritto in dettaglio le due finestre principali di Aladin, presenteremo 
gli altri menu.
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5.3 Modificare  la  distribuzione  delle  intensità  dei 
pixel

Icona: pixel 
Menu: Immagine => Contrasto e istogramma 
Tastiera: Ctrl+M

Aladin implementa un algoritmo automatico per regolare la distribuzione delle intensità 
dei pixel delle immagini. Le immagini sono spesso caratterizzate da una larga dinamica 
dei pixel e  a volte  sono presenti  valori  inattesi  (bordi del  sensore,  saturazione,  pixel 
bruciati); la visione monocromatica (o in falsi colori) può restituire soltanto 256 valori. 
Aladin ricampiona i pixel con lo scopo di applicare una soglia: tutti i pixel il cui valore è 
al di sotto del limite inferiore appariranno bianchi, mentre quelli al di sopra del limite 
superiore appariranno neri; i pixel intermedi verranno convertiti linearmente in valori 
da 0 a  255.  Nella  maggior  parte  dei  casi  l'algoritmo “autocut”  fornisce  un contrasto 
adeguato.

I 256 valori  dei pixel possono essere 
visualizzati  sia  in  scala  di  grigi  (in 
positivo  o  in  negativo)  o  a  colori 
tramite  una  tavolozza  che  mette  in 
corrispondenza  ciascun  valore  con 
uno specifico colore.
Può  comunque  succedere  che 
l'algoritmo autocut non si adatti bene 
all'immagine che si vuole visualizzare. 
Per  modificare  manualmente  la 
distribuzione delle intensità dei pixel 
utilizzare  il  menu  “Immagine  => 
contrasto e istogramma”,  oppure l'icona 
“pixel” della barra degli strumenti.

La  finestra  di  mappatura  dei  pixel 
appare come segue:
 Una barra che indica come appare 

la distribuzione;
 Un  istogramma  che  mostra  la 

distribuzione tra il valore minimo 
e massimo presi da Aladin;

 Tre cursori;
 Una zona con le informazioni..

In un click!

Per aumentare o diminuire il contrasto dell'immagine senza modificare l'intervallo dei 
valori dei pixel, modificare la funzione di trasferimento selezionata:
 Log: massimo contrasto
 Sqrt: contrasto elevato
 Linear: normale
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 Pow2: poco contrasto

Per affinare la distribuzione delle intensità dei pixel leggere quanto segue.

Informazioni sui pixel

Nella  parte  inferiore  della  finestra  appaiono  i  valori  massimo  e  minimo  esistenti 
nell'immagine, assieme ai limiti inferiore e superiore stimati in automatico da Aladin. 
(“autocut limits”).
La curva sovraimposta all'istogramma indica la funzione di trasferimento utilizzata per 
far  corrispondere  i  valori  dei  pixel  ai  256 livelli  disponibili.  Di  default  questa  è  una 
semplice linea obliqua poiché 1) di default la conversione è lineare, 2) la tavolozza di 
colore è livelli di grigio, cioè le tre componenti rosso, verde e blu visualizzate avranno 
sempre gli stessi valori. Una tavolozza di colore a colori ha tre curve distinte, una per il 
rosso, una per il verde e una per il blu. Muovendo il mouse sull'istogramma il valore del 
pixel  viene  visualizzato  in  ascissa,  mentre  i  corrispondenti  valori  rosso,  verde  e  blu 
vengono indicati in ordinata, sul lato destro dell'istogramma. Simultaneamente il colore 
finale è indicato nella barra in alto.

Funzioni di trasferimento

Aladin utilizza di default una funzione di trasferimento lineare per correlare il valore del 
pixel  con  il  colore  della  tavolozza.  I  tre  cursori  sotto  l'istogramma  permettono  di 
cambiare  la  pendenza  ti  tale  funzione,  o  anche  di  utilizzare  due  pendenze,  una 
corrispondente ai primi 128 valori della tavolozza e una per gli ultimi 128.

Muovendo il cursore di sinistra e quello di destra 
si cambiano i limiti inferiore e superiore, mentre 
il  cursore centrale  regola il  contrasto (contrasto 
minore a sinistra e maggiore a destra).
Se viene premuto il tasto  Ctrl il cursore centrale 
diventa  un  rombo  ed  è  sensibile  anche  al 
movimento verticale del mouse. E' così possibile 
aumentare o diminuire la distanza tra il cursore 
di sinistra e quello di destra:  un metodo rapido 
per modificare la distribuzione delle intensità dei 
pixel.
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Nel pannello si possono anche scegliere altre funzioni di trasferimento, non lineari: log,  
sqrt, pow2. Come indicato prima, la funzione  log fornisce un'immagine con un elevato 
contrasto, sqrt fornisce un contrasto medio e pow2 un contrasto ridotto.

Tavolozze

Aladin  ha  alcune  tavolozze  classiche  per  l'utilizzo  astronomico,  che  possono  essere 
modificate tramite le funzioni di trasferimento e anche invertite.

Qui di seguito la lista di tavolozze disponibili,  con semplici  funzioni di trasferimento 
lineari e come appaiono in colori reali e invertiti.

 Gray:

 BB:

 A:

 Stern:

 Rainbow:

 Eosb:

 Fire:

Note: Gli utilizzatori di IDL possono anche caricare dinamicamente una tavolozza con le 
librerie IDL-Aladin (see 7.4).

Analisi rapida dei pixel

Muovendo il mouse sulla barra colorata nella parte altra della finestra Aladin utilizzerà 
momentaneamente una tavolozza specifica per evidenziare la posizione dei pixel 
corrispondenti nell'immagine.
L'immagine sarà visualizzata in scala di grigi e i pixel corrispondenti in rosso.
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Modificare la soglia iniziale 

Come  indicato  nell'introduzione,  ogni  volta  che  viene  caricata  un'immagine  Aladin 
effettua un taglio automatico. E' comunque possibile modificare i limiti iniziali inferiore 
e  superiore  specificandoli  esplicitamente.  Cliccando  su  “usa  l'algoritmo  di  taglio  
automatico di Aladin” Aladin applica l'algoritmo di taglio automatico, senza però toccare i 
pixel i cui valori rientrano nei limiti indicati.
Se il quadratino non viene spuntato, verranno adottati i limiti inferiore e superiore come 
indicati.  Il  pulsante  “Reset”  riporta la distribuzione delle  intensità dei pixel  al  valore 
originale dell'immagine.

Modificare la soglia iniziale è un processo abbastanza lungo (alcuni secondi, a seconda 
delle dimensioni dell'immagine), mentre una semplice modifica del contrasto tramite la 
funzione di contrasto è praticamente istantanea.

Immagini e casi specifici

Se si lavora con reali immagini a colori, o con un cubo di dati, la finestra viene adattata 
al tipo di dati.

Immagine a colori   
Aladin può visualizzare immagini a colori (JPEG, GIF, PNG o FITS). In questo caso non 
c'è un taglio automatico e la finestra dei pixel visualizza 3 istogrammi uno sull'altro, che 
corrispondono alla distribuzione dei pixel nelle 3 componenti rosso, verde e blu. 
Ogni componente ha i suoi tre cursori di controllo, come le immagini monocromatiche.
Tenere premuto il tasto SHIFT mentre si muove il mouse per sincronizzare le altre due 
componenti e modificare così tutte tre le componenti contemporaneamente. 
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Immagini cubiche   
Aladin permette di manipolare immagine cubiche (vedi 5.10 – associazioni di immagini 
e  FITS cubiche).  In  questo caso  l'istogramma delle  intensità  dei  pixel  è  riferito  solo 
all'immagine  corrente.  Se  cambia  l'immagine  visualizzata,  l'istogramma  viene 
aggiornato automaticamente.  Tutte le opzioni sono le stesse del caso di un'immagine 
singola. Se si lavora con cubi di dati pesanti (molte centinaia di megabytes), modifiche 
sulla  soglia  iniziale  possono  richiedere  molti  secondi  prima  che  il  risultato  sia 
visualizzato su tutte le immagini del cubo.

Regolazione  del  contrasto  nella 
visualizzazione 

Per  una  semplice  modifica  del  contrasto  è 
possibile utilizzare il pulsante destro del mouse 
direttamente sull'immagine.  Uno spostamento 
verticale modifica il contrasto, uno orizzontale i 
limiti.  Durante  l'operazione  la  tavolozza 
risultante  è  visualizzata  in  alto  sopra 
l'immagine.

5.4 Contorni

Icona cont 
Menu: Sovrapponi  => 
Mappa dei contorni … 
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Aladin ha uno strumento per estrarre i contorni che permette di generare le isotope di 
un'immagine.  Il  menu “Sovrapponi => Mappa dei  contorni  …”  apre  una  finestra  che 
permette di modificare il numero di isotope e il loro valore rispetto all'istogramma della 
distribuzione dei pixel dell'immagine. E' possibile ridurre il rumore dell'immagine prima 
dell'estrazione  dei  contorni.  E'  anche  possibile  limitare  l'estrazione  alla  parte  di 
immagine  visibile.  Quest'ultima  opzione  è  utile  per  ridurre  il  tempo  di  calcolo  su 
immagini molto grandi.

I contorni sono salvati in un piano della catasta, e sovrapposti sull'immagine iniziale e 
anche sulle altre (contengono le informazioni sulle coordinate). Questa proprietà 
permette di paragonare facilmente due immagini a differente lunghezza d'onda.
 

Suggerimento: le proprietà del piano dei contorni (menu: Modifica => Proprietà) 
permettono di modificare il livello e il colore di ciascun contorno.

5.5 Filtri sui cataloghi 

Icona filtro 
Menu: catalogo => Crea un filtro… 

Filtrare  i  cataloghi  è  un  potente  strumento  per  una  migliore  visualizzazione  delle 
sorgenti.

Situazione di default (nessun filtro)

Di default, Aladin visualizza le sorgenti con simboli grafici, tutte le sorgenti di un piano 
con lo stesso simbolo (forma e colore). Il simbolo è una funzione del numero di sorgenti 
(simboli più piccoli per i cataloghi più densi). Forma e colore dei simboli possono essere 
modificati dalle proprietà del piano (menu “Modifica => Proprietà”).

Potrebbe comunque risultare necessario correlare la forma e il colore dei simboli in base 
al valore delle misure associate a ciascuna sorgente.  
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In Aladin i filtri sono applicati a uno 
o  più  piani  di  cataloghi,  per 
modificare  come  vengono 
visualizzate le sorgenti.
I filtri lavorano con una o più regole 
che  indicano  ad  Aladin  come 
rappresentare  le  sorgenti  in  base ai 
valori delle misure.
Per  esempio  si  possono  graficare 
cerchi  proporzionali  alla 
magnitudine,  ellissi  di  errore per la 
posizione,  frecce  per  indicare  il 
vettore del moto proprio...

Mostrare un filtro nella catasta   
Un filtro è un piano particolare della catasta e viene applicato a a tutti i piani situati 
sotto di esso.

Filtri predefiniti 

Aladin ha alcuni  filtri  predefiniti  che corrispondono ad alcuni  casi  tipici.  Si  possono 
selezionare e applicare dal menu“catalogo => Filtri predefiniti”.

E'  però  spesso  utile  poter  personalizzare  i  filtri  o  crearne  di  propri  inserendo 
manualmente le regole (maggiori dettagli nella prossima sezione),
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Creare un filtro

Un  filtro  può  essere 
creato con l'icona “filtro”
nella  barra  degli 
strumenti  o  dal  menu 
“catalogo  => Crea  un 
filtro”.   Sono disponibili 
due modalità:
 “principiante”,  per 

utilizzare  filtri  pre-
definiti (vedi sopra);

 “avanzata”, per creare 
filtri personalizzati.

La  modalità  avanzata 
permette  di  definire  le 
proprie regole per i filtri, 
inserendole  nel  campo 
centrale  della  finestra,  e 
offre  una  serie  di  aiuti 
per la loro scrittura:
 vari  esempi  com-

mentati  che  possono 
essere  usati  come 
base di partenza 

 pulsanti  che  danno 
accesso  alle  colonne 
dei cataloghi caricati in Aladin.

 un bottone per accedere alle opzioni grafiche
 bottoni per accedere alle funzioni matematiche e alle unità disponibili.

E' anche possibile caricare un filtro precedentemente salvato.

Sintassi

Per  capire  la  sintassi  dei  filtri  analizziamo  i  seguenti  esempi.  Supponiamo  di  voler 
utilizzare il filtro “tipo di oggetto” e solo per le stelle brillanti. Il filtro può essere scritto 
come segue:  
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${B}<18 { draw ${OTYPE}   }
Verranno selezionate solo le righe per le quali il valore della colonna “B” (magnitudine in 
banda B) è minore di 18 e la visualizzazione sarà relativa alla colonna “OTYPE” (tipo di 
oggetto).

Un filtro base ha la seguente sintassi:: 
un_test { un_azione }

 Il test è opzionale e se non viene indicata nessuna condizione, il  filtro interesserà 
tutte le sorgenti.

 E' possibile indicare più di un'azione, separandole con il carattere ‘;' oppure andando 
a capo.

 E'  possibile  avere molti  gruppi  “test{azione}”  uno dopo l'altro.  In questo caso,  la 
prima azione della lista associata a “vero” sarà quella tenuta in considerazione, le 
altre saranno ignorate.

${class}="Star" {draw square}
${class}="Radio" {draw rhomb}
${class}="Galaxy" {draw plus}

 Le righe che iniziano con  ‘#’ sono commenti.

Test
 Il campo test utilizza i comuni operatori di confronto (=, !=, <, >, >=, <=).
 Può avere parentesi e gli operatori boleani AND (&&), OR (||), NO (!)
 Accetta operazioni matematiche (abs, cos, deg2rad, exp, ln, log, rad2deg, sin, sqrt, 

tan);

Esempio:  disegnare le sorgenti che corrispondono alla seguente 
espressione:

log( abs(${Fi})/${Fx} ) > 44 { draw }

 Utilizzare le virgolette (") per le frasi. Sono permessi ‘ ?’ e ‘*’ ;
 L'operazione “undefined(…)” abilita a vedere le righe che non hanno un valore definito 

nella colonna.

Azioni grafiche
Sono disponibili due opzioni:
 Draw: per disegnare una sorgente;
 Hide: poco utilizzata, nasconde le sorgenti corrispondenti.

Quando si utilizza “draw”, l'azione può essere sulla forma e/o sul  colore dei simboli. 
La sintassi è la seguente:

draw colore forma
La  finestra  dei  filtri  contiene  due  bottoni  per  la  veloce  selezione  di  colore  e  forma 
desiderati. 
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Le  funzioni  forma  e  colore  possono  essere  associate  alle  colonne  e/o  alle  funzioni 
aritmetiche.

Esempio:  Disegnare triangoli rossi: 
{ draw red triangle }
Esempio:  Disegnare ellissi

{ draw ELLIPSE(0.5*${MajAxis},0.5*${MinAxis},$
{PosAng}) }

Esempio:  Disegnare quadrati il cui colore sia una funzione della 
magnitudine

{ draw RAINBOW(${magB}) square }

Funzioni specifiche
 FILLCIRCLE: cerchio pieno;
 FIXEDCIRCLE: cerchio con determinate dimensioni (non in funzione dello zoom);
 PM:  vettore  le  cui  direzione  e  lunghezza  sono  una  funzione  di  due  angoli  che 

indicano il moto proprio;
 LINE: segmento, molto utile per rappresentare la correlazione tra due cataloghi.

Le opzioni  CIRCLE,  FILLCIRCLE e  RAINBOW accettano due parametri opzionali che 
indicano  il  minimo  e  il  massimo  del  parametro.  Per  esempio:  draw  CIRCLE($
{A},1,10) disegna  cerchi  proporzionali  ai  valori  della  colonna  “A”,  il  cerchio  più 
piccolo avrà raggio di 1 pixel,  il più grande di 10 pixel (in zoom 1x).

Se l'azione “draw” agisce su una stringa (p.es.  draw "star") o fa riferimento a una 
colonna (p.es.  draw ${ObjectClass}),  sarà visualizzata  la stringa del valore della 
colonna.
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Nomi delle colonne o UCD   
Il  riferimento  al  nome  di  una  colonna  avviene  con  la  seguente  sintassi:  $
{COLUMN_NAME}.  Questo metodo implica che il filtro sia dedicato a un catalogo 
specifico poiché è necessario conoscere i nomi delle colonne. Per descrivere i filtri  in 
modo più specifico, per esempio identificando la magnitudine indipendentemente dal 
nome assegnato a quella colonna dall'autore, Aladin utilizza gli UCD.

Gli UCD o “Unified Content Descriptors” caratterizzano le colonne indipendentemente 
dal catalogo. Un UCD è associato a ciascuna colonna indicandone la quantità fisica. Per 
esempio,  la  colonna  con  la  magnitudine  sarà  contrassegnata  con  l'UDC  “pos.mag”. 
L'elenco degli UDC è mantenuta da una commissione internazionale ed è disponibile 
su: http://www.ivoa.net/Documents/latest/UCDlistMaintenance.html.  La  maggior 
parte dei server astronomici forniscono i loro cataloghi sotto forma si VOTable che già 
contengono gli UDC.

Quando un filtro utilizza gli UDC, la sintassi è  $[UCD]. I caratteri ‘*’ e ‘?’ sono anche 
ammessi. Per esempio $[phot*] corrisponde alla prima colonna il cui UDC inizia con 
“phot”, cioè alla prima colonna con misure di magnitudine.

Riassumendo,  il  nome  di  una  colonna  viene  richiamato  con  le  parentesi  graffe“{}”, 
mentre il suo UDC viene richiamato con le parentesi quadre “[]”.

Esempio:  Disegnare un cerchio proporzionale alla magnitudine per tutte 
le sorgenti più brillanti di 12

$[phot*]<12 { draw circle(-$[phot*]) }

Per  semplificare  il  riferimento  alle  colonne,  la  finestra  dei  filtri  offre  due  bottoni 
“Colonne” e “UCD” che permettono di scegliere il nome della colonna o il suo UDC da 
una lista, e il testo relativo viene scritto automaticamente nella posizione del cursore.
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Se le sorgenti vengono selezionate nella visualizzazione, e quindi vengono visualizzate le 
misure associate, una colonna può essere selezionata con un semplice click nel pannello 
delle  misure.  Per  fare  questo  scegliere  il  sottomenu  “Pick…”   quando  si  clicca  su 
“Columns” o “UCDs”.

Unità fisiche   

Indicare le unità fisiche (p.es. arcmin, Jy, …)  nel testo evita di dover fare la conversione 
manuale per espressioni che utilizzano colonne i cui valori non sono espressi tutti nelle 
stesse unità. 
Le unità possono essere espresse come nell'esempio seguente: 

Esempio:  Disegnare un cerchio proporzionale al flusso X (UCD : 
phot.flux;em.X-ray) per tutte le sorgenti la cui energia sia maggiore della 

soglia indicata 
$[phot.flux;em.X-ray]>10^-8 erg/m^2/s
{ draw circle($[phot.flux;em.X-ray]) }

Modificare un filtro

Per modificare un filtro selezionare il piano corrispondente nella catasta e visualizzare le 
sue proprietà dal menu “Modifica  => Proprietà”

applicazione dei filtri

Per essere applicato,  un filtro  deve essere attivato  spuntando il 
quadratino del corrispondente piano nella catasta. Un filtro viene 
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applicato a tutti i piani sottostanti. Se un filtro è posizionato in una cartella nella catasta, 
sarà applicato ai soli piani appartenenti alla stressa cartella.

Filtri dedicati a un singolo piano con un catalogo

Alcuni server offrono una lista di filtri dedicata ai propri dati (Simbad, NED, Skybot…). 
Essi appaiono nel modulo di ricerca (vedi  5.2 Finestra di selezione del server) come una 
lista scorrevole.

Un filtro  dedicato  non appare  nella  catasta  e  si  applica  solamente  a  quello  specifico 
piano con il catalogo. Esso impedisce di applicare altri filtri a quel piano. La selezione di 
un  filtro  dedicato  può  essere  modificata  successivamente  attraverso  le  proprietà  del 
piano (menu Modifica => Proprietà…). Utilizzando il bottone “This filter on the stack for  
editing”, è possibile modificare le caratteristiche di un filtro dedicato e/o applicarlo a più 
piani.

Esempi di filtri genercici 

Cerchi in funzione 
della magnitudine

{
   draw circle(-$[phot.mag*])
}
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Ellissi di posizione
+
Visualizzazione 
standard

{
  draw ellipse(
   0.5*$[phys.angSize.smajAxis], 
   0.5*$[phys.angSize.sminAxis], 
   $[pos.posAng])
   draw
}

Quadrati blu per 
sorgenti brillanti

$[phot.mag*]<17 {
   draw blue square
}

Simboli di 
differenti colori a 
seconda del tipo di 
oggetto

$[src.class]="Star"
   {draw red square}
$[src.class]="Radio"
   {draw blue rhomb}
$[src.class]="Galaxy"
   || $[src.class]="Seyfert"
   {draw green plus}

Moto proprio

{
   draw pm(
      5*$[pos.pm;pos.eq.ra], 
      5*$[pos.pm;pos.eq.dec])
}

 

5.6 Correlazione tra cataloghi 

Icona: cross 
Menu: catalogo => Correlazione… 

Aladin integra uno strumento di correlazione tra le sorgenti dei cataloghi, con lo scopo 
di condividere le sorgenti tra due cataloghi. Lo strumento di correlazione analizza due 
piani di cataloghi, fa la correlazione e genera un nuovo catalogo contenente le sorgenti 
condivise. 
La finestra di correlazione è accessibile tramite l'icona “corr” o dal menu “catalogo  => 
Correlazione”.

Le tre modalità di correlazione

Aladin ha tre modalità di correlazione che possono essere selezionate dalle schede nella 
parte superiore della finestra di correlazione.
 Correlazione basata solo sulla posizione;
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 Correlazione  “per  campo”  basata  sugli  stessi  valori  di  una  colonna di  entrambi  i 
cataloghi (p.es. una identificazione);

 Correlazione basata sulla posizione, tenendo conto delle ellissi di errore.

Correlazione di posizione
Nel pannello della correlazione di 
posizione  si  possono  specificare 
due  cataloghi,  assieme  alle 
rispettive coordinate (ra, dec). 
Se non si presentano ambiguità, i 
nomi  delle  colonne  saranno 
selezionati  automaticamente  da 
Aladin.  E'  quindi  necessario 
indicare  il  limite  superiore 
dell'offset  (in  arcsec),  ed 
eventualmente  anche  il  limite 
inferiore,  tra  cui  saranno 
correlate le sorgenti. 

Alla fine, scegliere tra tre opzioni:
1. Quando  molti  oggetti  sono 

all'interno  del  cerchio  di 
correlazione,  saranno 
correlate  solo  le  sorgenti 
più vicine. 

2.  saranno correlate tutte le sorgenti;
3. saranno correlate tutte le sorgenti senza controparte..

Correlazione di campo (cross-ID)
La cross-ID (o correlazione di campo) consiste nell'unione di quelle sorgenti per le quali 
un valore è identico in entrambi i cataloghi. Questo tipo di correlazione è dedicato a un 
campo che identifica  ciascuna  sorgente  in  modo univoco,  p.es.  un identificatore,  un 
numero. Nei database questa è chiamata “joint”.

Correlazione con ellissi di errore
La  finestre  per  le  impostazioni  della  correlazione  con  ellissi  è  simile  a  quella  della 
semplice correlazione di posizione. La principale differenza è la possibilità di specificare 
non solo le colonne con le coordinate, ma anche quelle con gli errori sulla posizione. 
Questi errori dovrebbero essere espressi attraverso 3 campi che definiscono un'ellissi: 
semiasse maggiore, minore e angolo di posizione rispetto al nord.

Scegliere i campi da includere

Quando Aladin fà una correlazione, viene creato un nuovo catalogo con i risultati. Ogni 
coppia  di  sorgenti  correlate  corrisponde a  una  sorgente  nel  catalogo  risultante  e,  di 
default, saranno inclusi tutti i dati delle due sorgenti. Per evitare confusione sui nomi 
delle  colonne,  esse  sono  chiamate  automaticamente  con  “_tab1”  e  “_tab2” 
rispettivamente.
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Utilizzando le  “Opzioni  Avanzate” è  possibile  specificare  le  colonne da prendere,  così 
come assegnare prefissi o suffissi ai nomi delle colonne. 

Colonne e UCD  
Quando il puntatore del mouse passa sull'intestazione di una colonna, le intestazioni 
corrispondenti  tra  i  due cataloghi  vengono evidenziate  in blu.  Tale  corrispondenza è 
basata sugli UCD delle due colonne (un UCD è un singolo attributo di quella colonna che 
ne caratterizza il significato fisico – p.es. “pos.eq.dec” per la declinazione – vedi sezione 
5.5).
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Nota: Alcuni UCD appaiono solo una volta in una tabella (“meta_main”). 
Quindi, se la corrispondenza appare evidenziata di rosso, significa che c'è un conflitto tra 
gli  UCD.  Per  evitare  tale  conflitto  cliccare  sull'intestazione  della  colonna  principale 
tenendo premuto il tasto Ctrl. Senza ulteriori indicazioni viene indicata come principale 
la prima colonna del primo catalogo.

5.7 Calcoli con le colonne
Menu: catalogo => Aggiungi una nuova colonna …

I cataloghi forniscono dati che possono essere visualizzati nel “pannello delle misure” 
selezionando le sorgenti. 
Questi  dati  sono visualizzati  sotto forma di tabella,  a cui è possibile aggiungere delle 
colonne ottenute con operazioni algebriche sulle colonne originali.
Per esempio, è possibile  creare la colonna  “J-K”,  differenza tra le due colonne della 
magnitudine “J” e“K”.

Accesso alla finestra

La finestra per eseguire le operazioni sulle 
colonne  e  aggiungere  una  nuova  colonna 
può essere aperta sia cliccando col destro 
(o  click  tenendo  premuto  CTRL),  sulla 
tabella,  o dal  menu “catalogo  => aggiungi  
una nuova colonna…”. 
In questo ultimo caso è prima necessario 
selezionare  il  catalogo  su  cui  lavorare, 
selezionandolo nella catasta.

Informazioni  generali  sulla  nuova 
colonna

Per creare una nuova colonna è necessario 
specificarne  il  nome.  E'  anche  possibile 
specificare le unità di misura della nuova 
colonna, l'UCD (vedi  5.5 usare i filtri) e il 
numero di cifre decimali per i valori.
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Espressioni matematiche

Per creare una nuova colonna bisogna indicare l'espressione matematica utilizzata da 
Aladin per calcolarne i valori.
L'espressione va inserita nel box centrale chiamato  “Espressione”. La sintassi è quella 
standard delle espressioni algebriche.  La sintassi per far riferimento alle altre colonne è:

${column_name}
Per  evitare  errori,  la  finestra  principale  offre  una  serie  di  bottoni  con  i  nomi  delle 
colonne del catalogo prescelto. Un click del mouse su uno di essi inserisce la referenza a 
quella colonna nella posizione del cursore del mouse nel box.
I rispettivi bottoni permettono di inserire operatori matematici (+, -, *, /…) e funzioni 
aritmetiche (abs, cos, sin, rad2deg, …).

Generare una colonna

Dopo aver generato la colonna con il bottone  “Aggiungi nuova colonna”, i nuovi valori 
compaiono  sulla  destra  della  tabella  delle  misure.  Sono  visualizzati  di  color 
arancione/marrone per essere facilmente distinti  dai dati originali.  La nuova colonna 
può  essere  utilizzata  come ogni  altra  colonna  (ordinare  le  righe,  filtri,  ...)  e  salvata 
assieme al resto del catalogo.

5.8 Calibrazione astrometrica 
Menu: Immagine => Calibrazione astrometrica …

catalogo => Calibrazione astrometrica …

Quando  Aladin  sovrappone  le  sorgenti  su  un'immagine,  utilizza  la  soluzione 
astrometrica associata all'immagine. La soluzione astrometrica crea una corrispondenza 
tra ciascun pixel dell'immagine e un punto in cielo, e viceversa.
Ci sono vari metodi di proiezione della sfera celeste su un piano (tangente, sinusoidale, 
…). Aladin è compatibile con le principali proiezioni utilizzate in astronomia (SINUS, 
TANGENTIAL, AITOFF, ZENITAL_EQUAL_AREA, STEREOGRAPHIC, CARTESIAN, 
NCP, ZPN).

Informazioni sulla calibrazione astrometrica

Aladin  utilizza  tre  metodi  per  calcolare  la  calibrazione  astrometrica  di 
un'immagine:
 Nelle  immagini  in  formato  FITS,  la  calibrazione  astrometrica  è  contenuta 

nell'intestazione dell'immagine (secondo lo standard WCS)
 Per  le  immagini  JPEG  Aladin  riconosce  la  calibrazione  astrometrica  dalle 

informazioni  contenute  nei  commenti  (secondo  lo  standard  JPEG).  Questa 
calibrazione deve utilizzare la sintassi delle intestazioni delle FITS, seguita da '\n' 
alla fine di ogni riga.

61



 Infine, Aladin riconosce la calibrazione astrometrica se l'immagine è stata caricata 
secondo lo standard SIA dell'osservatorio virtuale (Simple Image Access, vedi 8.2 – 
formati di dati supportati).

Suggerimento: L'intestazione di una FITS può essere visualizzata dal menu  Modifica  
=> intestazione FITS.

Un'immagine può avere più di una calibrazione astrometrica, specialmente se esse sono 
state  generate  manualmente.  Per  passare  da  una  all'altra  aprire  il  pannello  delle 
proprietà dell'immagine e selezionare la calibrazione. 

Se  un'immagine  non  ha  una  calibrazione  astrometrica  Aladin  può  comunque 
visualizzare l'immagine, ma non sarà capace di sovrapporre i cataloghi e altri elementi 
basati  sulle  coordinate  astronomiche.  Muovendo  il  mouse  sull'immagine,  il  campo 
posizione restituisce “Nessuna riduzione astrometrica”. E' comunque possibile aggiungere 
elementi  grafici  manualmente;  questi  elementi  avranno  solo  le  coordinate  XY 
dell'immagine.

Creare/modificare la calibrazione astrometrica

Aladin  permette  di  creare  la  calibrazione  astrometrica  per  le  immagini  che  ne  sono 
prive. Per fare ciò selezionate il piano dell'immagine nella catasta (cliccare sul nome) e 
poi utilizzare il menu “Immagine => Calibrazione astrometrica …”

Innanzi tutto inserire nella finestra di calibrazione il nome della nuova calibrazione.

Ci sono tre metodi per creare/modificare una calibrazione:
 Per parametri;
 Per stelle corrispondenti;
 Secondo il WCS dell'header.

Calibrazione per parameti
La prima scheda visualizza i parametri della 
calibrazione, p.es. una posizione celeste e le 
rispettive  coordinate  XY  sull'immagine,  le 
dimensioni  angolari  dei  pixel,  il  metodo  di 
proiezione,  l'angolo  di  rotazione  rispetto  al 
nord  e  la  direzione  lungo  la  quale 
l'ascensione retta cresce.
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Calibrazione  secondo  il  WCS   
dell'intestazione
La  terza  scheda  visualizza  le  informazioni 
dell'intestazione  FITS  che  forniscono  i 
parametri  per  la  calibrazione  secondo  lo 
standard WCS. 
E'  possibile  modificare  direttamente  i 
parametri  WCS.  Per  esempio,  si  può 
importare  la  calibrazione  astrometrica  di 
un'altra immagine semplicemente copiando e 
incollando i parametri.

Suggerimento:  I  valori  dei  parametri  WCS 
possono essere modificati anche attraverso il 
comando  di  script   set  PlanID 
FITS:keyword=value.

Calibrazione per stelle corrispondenti
La seconda scheda contiene una tabella in cui inserire una serie di punti dell'immagine 
(coordinate XY) e le corrispondenti coordinate celesti. E' un metodo flessibile e potente 
per  ottenere  velocemente  delle  buone  calibrazioni.  Qui  descriviamo  brevemente  il 
metodo,  per  ulteriori  dettagli  fare  riferimento  al  tutorial  online  dedicato  a  questa 
operazione (http://aladin.u-strasbg.fr/tutorials/aladin.gml).

Assumiamo di aver caricato nel pannello di sinistra un'immagine JPEG non calibrata, e 
un'immagine DSS dello stesso campo, con sovraimposto un catalogo come UCAC2, nel 
pannello di destra. Il metodo per calibrare l'immagine JPEG è di cliccare in successione 
su  una  stella  dell'immagine  non  calibrata  e  successivamente  sulla  sorgente  UCAC2 
corrispondente.  Ad  ogni  click  del  mouse  Aladin  compila  la  tabella  nella  finestra  di 
calibrazione. In genere 4 misure sono sufficienti per ottenere una buona calibrazione.
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Nota:  Quando si prendono le coordinate di una stella cliccando con il mouse, Aladin 
utilizza un algoritmo che calcola il centroide. Se non è possibile determinare il centroide 
(stella troppo grande), appare un messaggio per segnalare che verrà presa la posizione 
del mouse.

Suggerimenti:
 Potrebbe essere utile applicare la simmetria all'immagine DSS per farla apparire con 

un'orientazione simile all'immagine da calibrare (Immagine => Simmetria)
 E' consigliabile visualizzare solo le stelle brillanti con un piccolo moto proprio. 

Utilizzare un filtro facilita il puntamento delle sorgenti corrispondenti, per esempio: 
$[pos.pm;pos.eq.dec]<3 mas/yr && $[pos.pm;pos.eq.ra]<3 mas/yr
 && $[phot.mag*]<17  { draw circle(-$[phot.mag*]) }

 E'  possibile  non  caricare  il  catalogo,  le  coordinate  celesti  saranno  quelle  della 
calibrazione dell'immagine DSS. La precisione della calibrazione sarà però inferiore.

 Utilizzando  la  trasparenza  (Menu  “immagine  => livello  di  trasparenza”) per 
visualizzare l'immagine appena calibrata sopra quella DSS e verificare facilmente la 
qualità della calibrazione.

Ripeti e annulla
Durante  il  processo  di  creazione,  o  di  aggiustamento,  della  calibrazione,  è  possibile 
tornare indietro alla soluzione astrometrica precedente utilizzando i bottoni “Ripeti” e 
“Annulla” nella parte inferiore della finestra. 

Calibrazione di un catalogo

Aladin  offre  anche  la  possibilità  di  calibrare,  o  ricalibrare,  un  catalogo.  Questo 
corrisponde al calcolo, per ciascuna sorgente, della sua posizione celeste. Selezionare il 
piano  del  catalogo  nella  catasta  e  utilizzare  il  menu  “catalogo  => Calibrazione 
Astronomica…”. L'interfaccia e i metodi sono gli stessi utilizzati per le immagini..

Muoversi con il mouse
Se si  sta  utilizzando  il  metodo di  calibrazione  per  parametri  (1a scheda),  è  possibile 
spostare  nella  visualizzazione  la  sorgente  da  un  catalogo  da  calibrare,  per  vedere 
direttamente i risultati. Per fare questo selezionare la sorgente e spostarla con il mouse, 
le  altre  sorgenti  la  seguiranno.  Durante  lo  spostamento  i  parametri  di  calibrazione 
verranno aggiornati automaticamente. Lo spostamento viene convalidato con i pulsanti 
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“CREA” o “MODIFICA” che calcolano le nuove posizioni in accordo con lo spostamento 
indicato.

Catalogo con sole posizioni XY
Se viene caricato un catalogo o una tabella senza le coordinate celesti degli oggetti, ma 
con due colonne col la loro posizione XY che Aladin può rilevare (basandosi sul nome 
delle colonne sugli UCD associati), la finestra di calibrazione del catalogo viene aperta 
automaticamente, invitando l'utente a creare la calibrazione per tali sorgenti. 

Salvare un catalogo calibrato
Quando  un  catalogo  viene  salvato  dopo  la  calibrazione,  Aladin  aggiunge 
automaticamente due colonne con le coordinate celesti di ciascuna sorgente. 

5.9 Comporre un'immagine RGB 

Icona: rgb
Menu: Immagine => costruisci immagine RGB…

Aladin  può  creare  un'immagine  a 
colori partendo da 2 o 3 immagini in 
scala di grigi. La prima immagine sarà 
la  componente  rossa,  le  successive 
rispettivamente le componenti verde e 
blu.  L'immagine a colori  sarà salvata 
in un piano della catasta.

Suggerimento:  Se  il  cursore  del 
mouse viene posizionato sull'icona del 
piano RGB, le icone dei tre piani con 
cui esso è stato generato appaiono del 
colore della rispettiva componente. 

Ricampionamento

Per  fare  corrispondere  i  pixel  delle 
immagini  che hanno la stessa posizione 
in  cielo,  Aladin  effettua  il 
ricampionamento  di  due  delle  tre 
immagini  prendendo come campione la 
terza immagine. Questa immagine viene 
chiamata  “immagine  di  riferimento”.  Di 
default,  l'immagine  di  riferimento  è 
quella con le minori dimensioni dei pixel. 
Il  ricampionamento  sfrutta  l'algoritmo 
“nearest neighbour pixel”.
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Accesso alla finestra RGB

La finestra per generare un'immagine a colori può essere aperta dal menu “Immagine => 
Crea un'immagine a colori…” o tramite l'icona “rgb”.

La scelta di default per le immagine di ciascuna componente dipende dalle immagini 
caricate  nella  catasta.  Se  ci  sono  solo  due  o  tre  piani  selezionati,  Aladin  li  utilizza 
automaticamente,  altrimenti  Aladin utilizza le tre (o due) immagini poste più in alto 
nella catasta. Se è nota la lunghezza d'onda dell'immagine, Aladin ordina le immagini 
con tale parametro.

Caso specifico con due immagini

E' possibile selezionare anche solo 2 immagini. In questo caso la 
terza componente sarà calcolata facendo la media delle prime due 
immagini. Questo metodo fornisce delle belle immagini a colori se 
la componente libera è il colore verde (di default). 

Differenza tra due immagini  
E'  anche  possibile  fare  una  sottrazione  a  colori  tra  due 
immagini.  Le  differenze  positive  saranno  visualizzate  con il 
colore della prima componente, le negative con quello della 
seconda  componente.  Inoltre,  le  differenze  saranno 
normalizzate  tra  0  e  255  per  avere  il  massimo  contrasto. 
Questo metodo è interessante per visualizzare velocemente le 
differenze tra due immagini.

5.10 Associazioni di immagini: cubi e mosaici 

Icona: assoc
Menu: Immagine => Costruisci un mosaico

Immagine => Genere un'animazione

Aladin può associare due o immagini combinandole in un 
cubo che sarà visualizzato come un'animazione, oppure 
creando un mosaico di immagini.

Aprire la finestra delle associazioni

La  finestra  può  essere  aperta  dal  menu  “Immagine  => 
Costruisci  un  mosaico”  o  “Immagine  => Genera 
un'animazione”,  oppure  con  l'icona  “assoc”.   Si  possono 
indicare  i  piani  originali  dell'immagine,  il  ritardo  della 
sequenza  se  si  crea  un'animazione  e  l'immagine  di 
riferimento se è necessario il ricampionamento dei pixel.
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Mosaico

L'immagine ottenuta da un mosaico ha le corrette dimensioni per contenere le immagini 
originali nel sistema di proiezione dell'immagine di riferimento e può essere manipolata 
come  qualsiasi  altra  immagine  di  Aladin.  Per  le  regioni  che  si  sormontano  viene 
utilizzata la media.

Cubo o “sequenza animata"

Un  cubo  di  dati  viene  visualizzato  in  Aladin  come  una  sequenza  animata,  cioè 
un'immagine dopo l'altra.

Suggerimemto: E'  possibile  aggiungere  una  nuova  immagine  a  un  cubo  esistente: 
trascinare nella visualizzazione del cubo il piano della nuova immagine da aggiungere. 
Dopo  una  breve  pausa  necessaria  per  il  ricampionamento  della  nuova  immagine, 
l'animazione riparte con un'immagine in più.

5.11 Ricampionamento
Menu: Immagine => Ricampionamento…

Principio

Anche se è  rappresentata  la stessa regione di  cielo,  ciascuna immagine spesso ha la 
propria  soluzione  astrometrica.  Questo  significa  che  ciascun  specifico  pixel  non 
corrisponde necessariamente alla stessa regione di cielo. Per confrontare due immagini, 
pixel per pixel è quindi necessario ricampionare un'immagine prendendo l'altra come 
riferimento. In poche parole Aladin legge la posizione dei pixel dell'immagine, ottiene le 
loro coordinate in cielo e, utilizzando la soluzione astrometrica della seconda immagine 
per ogni posizione trovata precedentemente, calcola il valore del pixel (il più vicino alla 
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posizione trovata o una approssimazione bilineare dei 4 pixel più vicini). Ala fine del 
processo si hanno due immagini sulla stessa “griglia” di pixel  con un'unica soluzione 
astrometrica.

Aprire la finestra

La  finestra  di  ricampionamento  può  essere 
aperta  con  il  menu  “Immagine  => 
Ricampionamento”.   Prima  di  tutto  bisogna 
selezionare  nella  catasta  l'immagine  da 
ricampionare.  Nella  finestra  di 
ricampionamento  selezionare  l'immagine  di 
riferimento,  specificare  se  prendere  o  meno 
tutti i valori dei pixel o solo i livelli di grigio (8 
bit – più veloce), il metodo per il calcolo del 
valore  dei  pixel  e  se  sostituire  nella  catasta 
l'immagine originale con la nuova.

Attenzione: Notare che il metodo di ricampionamento in Aladin non conserva il flusso 
(cioè la somma dei valori dei pixel prima e dopo il ricampionamento).

Nota: Un'immagine ricampionata appare con il seguente logo nella visualizzazione: 

Suggerimento: Utilizzare la trasparenza (vedi 5.1) è un'alternativa più veloce e flessibile 
del  ricampionamento.  E'  però  meno precisa  in  quanto  non agisce  pixel  per  pixel,  è 
basata  sulle  coordinate  dei  quattro  angoli  e  fa  un'approssimazione  globale  per  la 
posizione degli altri pixel.

5.12Operazioni aritmetiche sulle immagini 
Menu: Immagine => Operazioni aritmetiche …

Immagine => Convoluzione
Immagine => Normalizzazione dei pixel

Addizione,  sottrazione,  moltiplicazione  e 
divisione

Aladin  offre  una  semplice  interfaccia  per  fare 
operazioni  aritmetiche  sulle  immagini:  somma, 
sottrazione, moltiplicazione e divisione. La finestra 
di controllo può essere aperta dal menu “Immagine 
=> operazioni  aritmetiche” (accessibile  se  nella 
catasta  ci  sono  almeno  due  immagini).  Aladin 

procede  pixel  per  pixel  facendo,  se  necessario,  un  ricampionamento della  seconda 
immagine  (vedi  5.11).  Prima  potrebbe  essere  utile  normalizzare  i  pixel  delle  due 
immagini in modo che i loro valori siano attorno a 1, dividendo per il valore medio dei 
pixel. Il risultato dell'operazione sarà visualizzato in un nuovo piano nella catasta.
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Suggerimento: Per  utilizzare  un  secondo  operando  che  non  sia  un'immagine  (p.es. 
Aggiungere un dato valore a tutti i pixel), utilizzare i comandi di script : +, -, *, /(vedi 
7.1)

Convoluzione

Il  menu “Immagine  => Convoluzione …” permette di “convolvere” l'immagine corrente 
con uno specifico vettore, p.es. generare una nuova immagine come prodotto di ciascun 
pixel dell'immagine originale (e dei pixel vicini) con un dato vettore.
Il  sottomenu  fornisce  i  vettori  comunemente  utilizzati  in  astronomia  (Gauss,  Mex, 
TopHat…)  con  differenti  misure.  E'  anche  possibile  definire  la  propria  matrice  di 
convoluzione utilizzando il comando di script: “conv”. L'immagine risultante sostituisce 
quella  originale  nella  catasta.  Se si  vuole  conservare l'immagine originale,  duplicarla 
prima di applicare la convoluzione (menu: “Immagine => Duplica piano immagine”).

5.13  Salvare, esportare e stampare 
Icona:  
Menu: File => Salva, File => Esporta

File => Backup, File => Stampa
Tastiera: Ctrl +S,  Ctrl +P

Utilizzando  l'icona  nell'angolo  in  alto  a  sinistra,  sotto  la  barra  dei  menu,  che 
rappresenta  un  floppy  disk,  si  ha 
accesso  alla  finestra  per  salvare  ed 
esportare il lavoro. E' anche possibile 
accedere  alle  varie  azioni  e  opzioni 
direttamente dal menu “file”.

Aladin offre molte opzioni per salvare il lavoro:
 stampare la visualizzazione;
 salvare  la  visualizzazione 

corrente  come  immagine.  I 
formati  supportati  somo 
BMP,  JPEG,  PNG e  EPS. 
Quest'ultimo  formato  è 
consigliato  per  le 
pubblicazioni scientifiche;

 backup  della  catasta  per  un 
utilizzo successivo;

 esportare uno o più piani ella 
catasta. Le immagini saranno 
esportate in FITS o JPEG (per 
immagini a colori), i cataloghi 
in  TSV  (Tab-Separated-
Value) o VOTable (vedi 8.2);

 accedere  all'URL 
dell'immagine o del catalogo..
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Generare una mappa cliccabile

Aladin permette di salvare la visualizzazione nel formato “PNG+LINK”. Questo formato 
è dedicato alla creazione di una mappa cliccabile per il web. La visualizzazione è salvata 
nel  classico  formato  PNG.  Simultaneamente  viene  generato  un  secondo  file  con 
estensione  “link”,  con  un  codice  ASCII  con  la  posizione  degli  oggetti  presenti  nella 
visualizzazione e l'URL per accedere a tutte le informazioni associate. Entrambi i file 
sono salvati su un server web e permettono di costruire facilmente una mappa sensibile. 
Per  maggiori  dettagli  su  questo  metodo,  il  formato  e  gli  esempi,  andare  su: 
http://aladin.u-strasbg.fr/java/FAQ.htx#Map

5.14Preferenze dell'utente
Menu: Modifica => Preferenze …

Aladin  raccoglie  nel  pannello  delle  preferenze  la  maggior  parte  dei  parametri  di 
configurazione che riguardano l'utente. 
Si possono definire i seguenti elementi:
 la lingua dell'interfaccia grafica (inglese, francese, italiano, ...);
 la  modalità,  es.  “astronomer”  per  i  professionisti,  “undergraduate”  per  gli  studenti, 

oppure una semplice finestra di visualizzazione (“preview”).

 la cartella di default in cui Aladin salva i file;
 la modalità di default di visualizzazione dei pixel (colori invertiti, tavolozza di colore, 

…); 
 il carattere utilizzato per separare le colonne in un file ASCII (TAB, ‘ ;’, …) ;
 attivazione dei filtri dedicati (vedi 5.5 – utilizzo dei filtri);
 valore di trasparenza dei campi di vista degli strumenti (vedi 5.2.6 - FoV);
 il  server delle  immagini  (quando la  ricerca avviene immettendo semplicemente  il 

nome dell'oggetto);
 il sito web con la lista dei server (vedi 5.2.1 – finestra di selezione del server), cioè la 

macchina  che  fornisce  a  ogni  avvio  la  lista  dei  server  disponibile,  e  i  relativi 
parametri;

 il browser web predefinito sul proprio computer;

Il pannello delle preferenze permette anche di:
 tradurre Aladin nella propria lingua (vedi sotto);
 Ricreare durante la sessione la lista dei server, che reinizializza anche la cash dei 

metadata di Aladin.

Alcuni parametri non sono modificabili (p.es. Le dimensioni e la posizione della finestra 
di Aladin, il tipo di reticolo -classico o largo-, ecc.), ma possono essere semplicemente 
mantenuti da una sessione all'altra.
Suggerimento: I parametri di configurazione sono salvati nel file ASCII “Aladin.conf” 
che può essere editato. Il file si trova nella cartella Aladin situata nella propria home 
($HOME su linux, \Document and Settings\YourName in Windows). Per reinizializzare 
i parametri è sufficiente cancellare tale file..
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Gestione delle traduzioni

Aladin supposta traduzioni in molte lingue della sua interfaccia grafica. Se la propria 
lingua non è supportata è possibile creare una nuova traduzione. Utilizzare il pulsante 
“New  translation?"  e  specificare  -in  inglese-  la  lingua  e  le  due  lettere  del  codice 
corrispondente (es. “Italian” –“it”). Aladin apre una finestra editabile con le espressioni 
(in inglese) che dovranno essere tradotte, quelle che sono già state tradotte, se esistono, 
e quelle che non sono più necessarie (es. quelle utilizzate da una versione precedente del 
software).  La  propria  traduzione  può  essere  installata  e  apparirà  dalla  sessione 
successiva come una nuova lingua. 

Dettagli:
 le espressioni non tradotte appaiono in inglese.
 Aladin supporta linguaggi non ASCII (es. Cinese) ed eventualmente scritti da destra a 

sinistra (es. Persiano).
 E' possibile completare o correggere una traduzione esistente. Prima di tutto caricare 

la lingua desiderata, poi utilizzare la funzione “nuova traduzione” lasciando vuoti i 
campi “lingua” e “codice”. Le modifiche della traduzione vengono applicate solo alla 
propria installazione di Aladin..

Nota: per rendere partecipe tutta la comunità dei miglioramenti apportati, contattare il 
CDS e il team di sviluppo di Aladin. La propria traduzione viene salvata in un file nella 
stessa  cartella  del  file  di  configurazione  (vedi  sopra)  con  il  nome  “Aladin-lingua-
versione-perso.string…”.

5.15  Console degli script 
Menu: Strumenti => Finestra degli script …
Tastiera: F5

Tutte le azioni che possono essere fatte con l'interfaccia grafica possono anche venire 
eseguite da riga di comando. Lo 
scopo  è  di  riuscire  a  utilizzare 
Aladin in modalità di “script” per 
svolgere  lavoro  ripetitivo  o 
controllar Aladin da remoto. 

Questi  comandi  possono  essere 
sottomessi  attraverso vari  canali 
tra cui:
 La finestra principale
 La finestra degli script

la finestra  di  script  viene aperta 
dal menu “strumenti => finestra 
degli  script…”.  I  comandi  tra 
parentesi sono quelli  equivalenti 
ai  comandi  dati  attraverso  l'interfaccia  grafica.  Questo  è  un utile  aiuto  per capire  la 
sintassi. I comandi possono essere inseriti direttamente dopo “Command>”. 
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Le freccie UP e DOWN permette di scorrere i comandi sottomessi in precedenza per re-
editarli, modificarli o sottometterli di nuovo.

Suggerimento: fare  attenzione  a  scrivere  sempre  dopo   “Command>”.  Se  non  è 
visualizzato premere il tasto Invio per passare a una nuova linea.

Alternativa alla finestra di script

Per  dare  rapidamente  un  comando  senza  aprire  la  finestra  degli  script,  è  possibile 
scriverlo  direttamente  nel  campo  di  posizione  utilizzato  da  Aladin  per  indicare  la 
posizione attuale del mouse.

Fare  riferimento  alla  sezione  “Aladin  da  script”  (vedi  7.1,  sotto)  per  avere  maggiori 
informazioni sull'utilizzo di Aladin tramite script.

6 Strumenti aggiuntivi
Aladin fornisce l'accesso ad alcuni strumenti supplementari:
 Puntatore automatico di Simbad;
 Possibilità di utilizzare macro per operazioni ripetitive;
 Un protocollo per interagire con altre applicazioni astronomiche compatibili con gli 

standard dell'Osservatorio Virtuale;
 Uno strumento per individuare le sorgenti presenti in un'immagine : S-extractor
 Generatore di etichette.

Ciascuno di questi strumenti viene ora descritto brevemente.

6.1 Puntatore automatico Simbad

Menu :   Strumenti => Puntatore automatico Simbad

Per facilitare l'esplorazione delle sorgenti di un'immagine, attivare 
il  puntatore  automatico  Simbad,  che  attiva  una  connessione 
continua con il  database Simbad. Ogni  volta che il  mouse viene 
lasciato  fermo  per  alcuni  istanti,  Aladin  interroga  il  database 
Simbad e fornisce una lista di oggetti in quella posizione (con le 
relative informazioni).  Il  criterio  utilizzato per  la  selezione degli 
oggetti fa riferimento al numero di referenze bibliografiche. 
 
Nota: Se Simbad è già stato precedentemente caricato in un piano della catasta, Aladin 
lo utilizzerà per evitare numerose richieste al database Simbad online.
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6.2 Editor di macro

Menu : Strumenti => Impostazioni macro

Per semplificare l'esecuzione di operazioni 
ripetitive  Aladin  fornisce  la  possibilità  di 
utilizzare  macro  basate  sui  comandi  di 
script (vedi  7.1).   le macro permettono di 
inserire  nei  comandi  di  script  le  variabili 
per operare su una lista di oggetti.

La finestra di controllo delle macro è divisa 
in 3 parti:
 nella  pare  superiore  si  scrivono  i 

comandi di script. Le variabili vengono 
specificate con $1, $2 etc.

 nella parte centrale si scrivono i valori 
che fanno riferimento alle variabili

 la parte inferiore controlla l'esecuzione 
dello script.

Gli script e i valori delle variabili possono 
essere  salvati  (menu  della  finestra  delle 
macro  File   Salva  script→ )  per  un  uso 
successivo.

Suggerimento: Aladin  riconosce 
automaticamente la sintassi  degli  script  e 
colora  i  vari  elementi  per  facilitarne  la 
scrittura. I comandi sono anche “cliccabili” 
per ricevere aiuto.

6.3 Interazione con altre applicazioni VO: SAMP

Menu : Strumenti => Strumenti VO

Aladin implementa un protocollo (SAMP) per connettere altre applicazioni, per esempio 
software per creare grafici o visualizzare spettri. SAMP è la nuova versione del protocollo 
PLASTIC. 

Funzionamento di SAMP

SAMP  permette  a  varie  applicazioni  di  dialogare  fra  loro,  scambiandosi  dati  e 
interagendo. Per esempio, la selezione di una sorgente (o di un insieme di sorgenti) in 
Aladin è immediatamente seguita dalla selezione della stessa sorgente anche nelle altre 
applicazioni. 
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Configurazione degli strumenti VO

Aladin semplifica l'utilizzo di SAMP attraverso una finestra  che presenta un elenco di 
applicazioni che possono essere connesse ad Aladin. Tale finestra permette di installare 
facilmente le applicazioni, che appariranno poi nel menu “strumenti -> strumenti VO”. La 
lista  di  applicazioni  è  gestita  dinamicamente:  elenca  sempre  l'ultima  versione  delle 
applicazioni.

Connessioni SAMP

Per abilitare due applicazioni compatibili  con SAMP a interagire fra loro è in genere 
sufficiente avviare le due applicazioni. E' anche possibile avviare le due applicazioni dal 
menu  “Strumenti -> Strumenti VO” di Aladin.

La connessione tra le due applicazioni è in genere indicata nelle due applicazioni. Alcune 
applicazioni utilizzano un menu specifico ,  per esempio “Interop”  (TOPCAT, VOPlot, 
VOSpec,  Aladin…) o “File => SAMP” (DS9),  e la  connessione viene indicata con una 
piccola icona nella finestra dell'applicazione che è connessa (Virgo, Aladin).
Aladin indica la connessione SAMP con un'icona a forma di antenna nell'angolo in basso 
a destra della finestra principale. Quando viene stabilita una connessione con un'altra 
applicazione SAMP l'icona visualizza lo stato attivo tramite una serie di onde. 
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Il menu “Interop” permette di accedere alle funzioni SAMP e modificare le opzioni. E' 
anche possibile utilizzare  il menu contestuale cliccando sull'antenna (click destro o ctrl 
+ click).

Trasferimento di dati

Quando  Aladin  è  connesso  ad  altre  applicazioni  è  possibile  spedire  e  ricevere  dati 
(immagini, tabelle, …) e creare nuovi piani nella catasta. Per spedire dati selezionare il 
relativo piano nella catasta e aprire il menu “Interop” per indicare l'applicazione a cui 
inviare i dati.

Interazioni

In genere, quando i dati  sono tabelle o cataloghi, le sorgenti  selezionate in una delle 
applicazioni  vengono  automaticamente  selezi9nate  anche  nelle  altre.  E'  un  metodo 
pratico  per,  per  esempio,  mostrare  le  sorgenti  di  un  diagramma evidenziate  su  una 
mappa.
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Nota : Le azioni SAMP dipendono dall'applicazione, è possibile che la selezione di una 
sorgente sia semplicemente ignorata da un'altra applicazione SAMP, per questo è spesso 
necessario configurare le applicazioni.

6.4 Identificazione delle sorgenti con  SExtractor

Menu : Strumenti => Strumenti Remoti => S-extractor…

Aladin  non  include  strumenti  di  fotometria,  ma  fornisce  l'accesso  a  Sextractor, 
progettato appositamente per riconoscere le sorgenti e calcolarne la magnitudine (Bertin 
& Arnouts – 1996). 

Il menu “strumenti -> Strumenti Remoti -> S-extractor” apre la finestra di Sextraxtor, con 
una serie di opzioni. Queste includono l'immagine di riferimento da utilizzare e vari filtri 
da applicare al  momento di  visualizzare  il  risultato,  per  esempio disegnare  cerchi  di 
raggio proporzionale alla magnitudine della sorgente. 

Dopo  aver  indicato  le  opzioni  e  premuto  il  pulsante  “inoltra”,  lo  strumento  remoto 
Sextractor, che è un'installazione di Sextractor su un cluster di computer a Strasburgo, 
eseguirà i  calcoli  e consegnerà il  risultato che apparirà in un nuovo piano di Aladin 
(sovrimposto all'immagine).

Nota:  se  l'immagine  è  locale  (salvata  sul  proprio  pc)  potrebbe  essere  necessario 
autorizzare  l'applicazione  remota  a  utilizzare  temporaneamente  una  data  porta  del 
proprio  computer  per  avere  accesso  all'immagine,  Con questo  metodo ci  potrebbero 
anche  essere  ulteriori  problemi  con  il  provider  della  rete.  Comunque,  utilizzare 
un'immagine su un server esterno dovrebbe evitare ogni problema.

6.5 Generare le anteprime

Menu : Immagine => Generatore di anteprime

76



Aladin  permette  di  generare  facilmente 
l'anteprima  di  una  serie  di  immagini 
(ritagliando  per  ognuna  un'immagine  più 
piccola dall'immagine presente nella catasta).
La lista deve essere definita dalla selezione di 
oggetti di un catalogo in un piano della catasta 
oppure  una  serie  di  oggetti  taggati  in  modo 
interattivo.  Aladin  genererà  tante  anteprime 
quanti gli oggetti nella lista.

Esempio:

Supponiamo  di  voler  creare  un'anteprima  di 
tutte le nebulose planetarie presenti nella parte 
centrale dell'ammasso Coma:
 Caricare un'immagine DSS e sovraimporre il catalogo SIMBAD
 Selezionare  le  sorgenti  indicate  come  possibili  nebulose  planetarie  utilizzando  il 

campo di ricerca in basso a destra della finestra principale. Digitare semplicemente 
“PN?” nel campo di testo e premere “GO”. Vengono così selezionate tutte le sorgenti 
indicate come “PN?” in Simbad.

 Creare le anteprime dal menu “Visualizza-> generatore di anteprime”

Le  anteprime  così  generate  sono  automaticamente  bloccate,  cioè  non  vengono 
ingrandite o spostate in accordo con altre visualizzazioni; questo è indicato dal piccolo 
simbolo a forma di lucchetto nell'angolo in basso a sinistra di ogni anteprima.

Suggerimento: le  anteprime  possono  essere  cancellate  individualmente  (come  ogni 
visualizzazione) oppure tutte le visualizzazioni bloccate possono essere cancellate in una 
sola  volta.  Entrambe queste  opzioni  sono  disponibili  cliccando  con  il  destro  su  una 
visualizzazione. 

Suggerimento: lavorando con le molte visualizzazioni che possono essere create con la 
procedura appena descritta,  è  spesso utile  “fissare in primo piano” il  campo di vista 
originale, in modo che sia sempre visibile.
  

Anteprima di immagini multiple

Le  anteprime  possono  essere  generate 
contemporaneamente per più immagini, ed essere 
poi visualizzate una a fianco dell'altra.
Per esempio, per confrontare le anteprime di una 
serie  di  sorgenti  in  due  immagini,  prima 
selezionare  le  visualizzazioni  delle  due  immagini, 
poi  le  sorgenti  desiderate  e  infine  generare  le 
anteprime.  Le  anteprime  risultanti  saranno 
disposte  in  modo  da  far  vedere  affiancate  quelle 
delle  due  immagini.  L'opzione  visualizzazioni 
multiple  può  essere  utilizzata  per  semplificare  il 
confronto. In questo caso sono utili le opzioni 2x1 e 
2x2.
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7 Aladin per esperti
In questa sezione vengono brevemente descritte le funzioni avanzate di Aladin, come:
 Utilizzare Aladin in modalità di script;
 Utilizzare Aladin come un applet;
 Estendere le funzionalità creando plugins Java per Aladin;
 Utilizzare IDL con Aladin

7.1 Aladin in modalità script
Come alternativa all'interfaccia grafica Aladin può essere controllo da riga di comando. I 
comandi possono essere digitati da riga di comando oppure venire implementati in un 
file di script.  I comandi di script possono essere inviati ad Aladin anche attraverso un 
altro programma.  

I vari modi di utilizzare gli script

I comandi di script possono essere utilizzati in diversi contesti:

 In alternativa al mouse 
 Per controllare Aladin 'da remoto' utilizzando un altro software:

 con un qualsiasi linguaggio di script, es BASH o PERL
 con  il  metodo  “execCommand(String)”: qualunque  altra  applicazione  che 

condivide  la  stessa  Macchina  Virtuale  Java  (JVM)  può  interagire  con  Aladin 
(vedi - http://aladin.u-strasbg.fr/java/FAQ.htx#Launch)

 con il metodo “execAsyncCommand(String)”, per controllare Aladin in modalità 
applet con  JavaScript (vedi sotto).

 Avviare un applet di Aladin (vedi sotto)
 Scrivere macro (vedi sotto)

Esempio di script:

Esempio : Scaricare un'immagine da un URL,  aggiungere un piano 
SIMBAD, attivare la griglia di coordinate, e specificare una tavolozza (BB) 

per la visualizzazione:
get File(http://myServer/mImage.fits)
sync
get Simbad
grid on
cm bb noreverse
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Elenco dei comandi di script di Aladin

Per maggiori informazioni sui comandi di script utilizzare il menu “Aiuto -> Aiuto sui  
comandi di script”.  La pagina di aiuto online viene aperta nella finestra principale di 
Aladin. Ogni comando può essere cliccato per una spiegazione più dettagliata sul suo 
utilizzo e sui parametri di input.

Utilizzo dei piani della catasta come variabili. 

Negli  script  è  possibile  utilizzare  i  piani  della  catasta  come  variabili.  I  piani  sono 
identificati  dal  loro  nome  o  dalla  loro  posizione  nella  catasta.  I  comandi  di  script 
permettono  anche  di  creare  un  nuovo  piano  “PlaneName  =  command…” .  Per  far 
riferimento a un piano con la sua posizione nella catasta, “PlaneName” va sostituito con 
@nnn, dove nnn è il numero del piano. - @1 è il primo piano in basso. Se il piano con il 
numero specificato esiste già, verrà creato un nuovo piano in cima alla catasta.. 

Esempio :  Creare un piano chiamato  “MyImage” con un'immagine
DSS/ESO di  M1:

MyImage = get ESO(DSS1) M1
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Gli  script  sono molto  comodi  per  effettuare  operazioni  aritmetiche con i  piani  delle 
immagini  nella  catasta  (addizione,  sottrazione,  moltiplicazione,  normalizzazione, 
convoluzione...)

Esempio :  fare un'immagine differenza di due immagini nella bande J e F:
A = get Aladin(J) M1
B = get Aladin(F) M1
Diff = A – B

7.2 Rendere  i  propri  dati  visibili  nell'applet  di 
Aladin

Come  indicato  nella  sezione  2,  Aladin  può  essere  utilizzato  come  un'estensione  del 
browser web (IExplorer, Firefox, Mozilla …) sottoforma di applet Java. Questo metodo 
permette  ai  provider  di  dati  di  offrire  la  visualizzazione  dei  dati  senza  bisogno  di 
scaricarli o di installare programmi,

Avviare un applet di Aladin

Per avviare un applet Aladin è sufficiente collegarsi a uno specifico URL. Ci sono molti 
siti che utilizzano Aladin in tale modalità.

Suggerimento:  di default Aladin viene avviato all'apertura della pagina web. E' anche 
possibile avviare Aladin in una finestra separata, o in modalità “preview”. Per maggiori 
dettagli consultare le FAQ   http://aladin.u-strasbg.fr/java/FAQ.htx#startapplet   .  

Gestire l'applet di Aladin

Per visualizzare i dati nell'applet di Aladin questo deve essere comandato via script. Lo 
script  viene  inviato  attraverso  il  parametro  “-script”  nell'URL  che  richiama  l'applet, 
oppure utilizzando JavaScript.

Il parametro “-script”
L'URL utilizzato per chiamare l'applet accetta un parametri nella forma “-script=xxx”, 
dove  “xxx”  è  uno  script  di  Aladin.  Lo  script  può  essere  composto  da  più  comandi, 
separati da un punto e virgola “;”. lo script viene eseguito immediatamente dopo l'avvio 
dell'applet e permette di caricare i dati da visualizzare.

Esempio : Avviare l'applet caricando i dati da un file specifico e 
sovraimporre una griglia di coordinate

http://.../nph-aladin.pl?-script=get+File(http://xxx);grid+on

Tip: La pagina web di Aladin offre una procedura semplificata per produrre URL corretti 
che  contengono  varie  funzioni.  Vedi  –  http://aladin.u-strasbg.fr/java/nph-aladin.pl?
frame=form.
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Utilizzare JavaScript
Aladin  in  modalità  applet  può  anche  essere  controllato  attraverso  una  funzione 
JavaScript , con la seguente stringa: 

document.aladin.execAsyncCommand(script)

Al contrario  del  metodo precedente,  l'utilizzo del  parametro  “-script”  con JavaScript 
permette di modificare le impostazioni dell'applet. Non è necessario riavviare Aladin ad 
ogni nuovo set di dati da visualizzare.
Per  maggiori  informazioni  sull'utilizzo  di  Aladin con JavaScript  fare  riferimento  alle 
FAQ (http://aladin.u-strasbg.fr/java/FAQ.htx#JavaScript).  Per  informazioni  più 
generali  su  come  caricare  i  propri  dati  su  Aladin,  vedere  http://aladin.u-
strasbg.fr/java/HowToProvideMyData.htx   .  

7.3 Estensioni di Aladin:  “plug-ins”
Menu : Strumenti => Plugins…

Aladin è scritto nel linguaggio di 
programmazione  Java  ed  è 
possibile  aggiungere  delle 
estensioni  scritte  in  Java  per 
aumentare le sue potenzialità.

Installare i plugins

L'installazione dei plugin avviene 
tramite  l'apposita  finestra  di 
controllo,  accessibile  dal  menu 
“Strumenti => Plugins => Impostazioni 
plugin”
Nella finestra sono elencati tutti i 
plugin  installati.  L'opzione 
download  illustra  i  plugin 
disponibili  sul  sito  ufficiale  di 
Aladin.
I  plugin  devono  essere  installati 
compilati  (.class  o  .jar),  nella 
cartella  “.aladin/Plugins”  nella  propria  home.($HOME su  Unix, 
\document_and_Settings\yourName su Windows).  Dopo aver scaricato un plugin, 
è necessario premere il pulsante “ricarica”.

Scrivere plugin di Aladin

Scrivere un plugin richiede una buona conoscenza del linguaggio Java.  E'  necessario 
estendere la classe di oggetti “AladinPlugin” per avere accesso ai metodi richiesti per 
manipolare la catasta con le immagini e i cataloghi in essa contenuti,.
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La  documentazione  per  creare  i  plugin  è  disponibile  su  http://aladin.u-
strasbg.fr/java/FAQ.htx#plugins  ,   dove ci sono molti esempi per facilitare la scrittura di 
un plugin.

7.4 Interazione IDL / Aladin
IDL (Interactive Data Language) è un linguaggio e ambiente di programmazione spesso 
utilizzato per il trattamento delle immagini, con una significativa comunità di utilizzatori 
astronomi. Una serie di procedure IDL (file .pro) che permettono l'utilizzo di Aladin in 
ambiente IDL sono disponibili su 
http://aladin.u-strasbg.fr/java/idl_aladin  _  interface.tar.gz   .
E' così possibile scambiare immagini, tabelle, tavolozze, ecc. tra Aladin e IDL.
Per  maggiori  informazioni  sulle  librerie  Aladin  per  IDL  vedere:  http://aladin.u-
strasbg.fr/java/FAQ.htx#IDL.

8 Utilizzare Aladin
Il  software  Aladin è  frutto  di  oltre  10 anni  di  sviluppo,  molte  informazioni  pratiche 
possono  essere  trovate  nelle  FAQ  http://aladin.u-strasbg.fr/java/FAQ.htx.  Questo 
documento viene continuamente aggiornato per aggiungere le nuove funzionalità.
Ci sono anche numerosi tutorial ed esempi pratici online, utile risorsa per gli studenti. 
(http://aladin.u-strasbg.fr/tutorials/aladin.gml).

Le  seguenti  sezioni  presentano  alcune  note  sull'utilizzo  di  Aladin,  per  maggiori 
informazioni consultare le FAQ come menzionato sopra.

8.1  Profili utente
Aladin fornisce  un elevato numero di  opzioni  e  funzioni  per manipolare immagini  e 
cataloghi,  attraverso  una  relativamente  complessa  interfaccia  grafica.  E'  possibile 
modificare  l'interfaccia  per  assecondare  le  necessità  di  utenti  diversi,  per  esempio 
studenti, che preferiscono una versione semplificata. Sono disponibili due alternative: 
“undergraduate” e “preview”, oltre all'interfaccia standard “astronomer”.

Il profilo con cui viene avviato Aladin è definito nelle preferenze dell'utente (see 5.14). 

E' anche possibile utilizzare il comando “-outreach” da riga di comando.

8.2 Dati supportati
La maggior parte dei formati di dati utilizzati in astronomia, sia per le immagini che per 
i cataloghi, oppure per i metadati, sono supportati da Aladin. Sono anche supportati i 
principali metodi di compressione, 
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Formato Tipo di dati
Aladin 

logo
Commenti

FITS Immagine [+ WCS] No limiti di dimensioni

JPEG
Immagine a colori 
[+WCS]

< 100 Megapixels1

GIF Immagine a colori
PNG Immagine a colori

HCOMP
Immagine FITS 
compressa

Disponibile solo per le FITS

FITS- RGB Immagine [+WCS]

FITS-CUBE
Cubo di immagini 
[+WCS]

<1024x512x512

FITS-RICE
Immagine FITS 
compressa

Disponibile solo per le FITS

ASTRORES catalogo
Precursore delle VOTable (per 
compatibilità)

VOTABLE catalogo
Standard IVOA 
(base64,FITS…)
<1 milione di sorgenti

FITS-ST catalogo
Tabella ASCII FITS
<1 milione di sorgenti

FITS-SB catalogo
Tabella binaria FITS 
<1 milione di sorgenti

CSV & TSV catalogo
“Character separated value”
<1 milione di sorgenti

BSV catalogo
“Blank separated value”
< 1 milione di sorgenti

SEXTRACTOR catalogo Formato S-Extractor
MFITS Dati misti Estensione FITS multiple

AJ Catasta di Aladin Backup della catasta

AJS Script di Aladin Script

FOV Campo di Vista
Campo di Vista strumentale 
(IVOA)

IDHA Elenco di immagini
SIA, (supportato per 
compatibilità)

SIA
Elenco di immagini 
[+WCS]

IVOA standard
(< 10 000 righe)

SSA Elenco di spettri
 IVOAStandard
(< 10 000 righe)

GZIP Compressione
Può essere utilizzato con 
qualunque formato

Aladin  riconosce  automaticamente  il  formato  dei  dati,  analizzandone  il  contenuto. 
L'estensione del file e la definizione “Content-type”  non sono necessarie per le risorse 
online.

1 With 1 Gigabyte RAM
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Eccezione :  il  formato AJS (Aladin script)  è  un'eccezione a  questa  regola.  In caso di 
ambiguità,  Aladin cerca un file con estensione  .ajs e/o il  commento nella prima riga 
“#AJS”.

8.3 FITS e calibrazione astrometrica
Per quanto riguarda la calibrazione astrometrica,  Aladin utilizza  lo standard ufficiale 
delle FITS:  il  primo pixel in basso a sinistra ha coordinate  (1,  1)  e le corrispondenti 
coordinate astronomiche sono centrate al centro del pixel. Le coordinate del primo pixel 
sono quindi (0.5, 0.5).

Nota: IDL non segue lo standard ufficiale FITS, esso considera (0, 0) le coordinate del 
primo pixel.

Aladin riconosce diversi metodi di calibrazione: classici codici WCS, il vecchio standard 
DSS1, ecc. e supporta la maggior parte delle usuali proiezioni.

8.4 Prestazioni e caratteristiche tecniche
Lo sviluppo di Aladin ha le seguenti linee guida: 

1. massima compatibilità con l'hardware e i sistemi operativi,
2. migliori prestazioni

Per  soddisfare  queste  due  richieste  Aladin  è  stato  sviluppato  nel  linguaggio  Java.  Il 
software Java richiede un “java runtime environment” installato sul pc dell'utente, in 
genere  presente  su  tutti  i  sistemi  operativi.  E'  comunque  possibile  installare 
gratuitamente “java runtime environment” dal web.

Nell'angolo in basso a destra della finestra principale di Aladin è indicato l'attuale uso di 
memoria.  Passando  col  mouse  in  questa  zona  appaiono  maggiori  informazioni,  per 
esempio la massima memoria riservata ad Aladin.  Tale valore può essere aumentato 
solo prima dell'avvio di Aladin. Consultare la relativa sezione di FAQ (http://aladin.u-
strasbg.fr/java/FAQ.htx#huge).

8.4.1 Gestione delle immagini

Aladin  può  caricare  immagini  di  qualsiasi  dimensione.  A  seconda  della  propria 
configurazione hardware e delle impostazioni sulla memoria riservata alla java run time 
machine, Aladin sceglie la procedura migliore tra le seguenti tre:
 immagini di pochi Mb: caricate completamente nella memoria;
 immagini di poche centinaia di Mb: Aladin sfrutta temporaneamente spazio su disco 

per salvare i valori completi dei pixel. Gli effetti sulla fluidità del lavoro non sono 
realmente visibili;

 immagini  di molti  Gb: Aladin utilizza una strategia in due fasi,  una prima rapida 
visualizzazione a bassa risoluzione di tutta l'immagine, e quando l'utente ingrandisce 
una zona sufficientemente piccola, viene caricata dallo spazio su disco l'immagine ad 
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alta  risoluzione.  Tale  strategia  in  due  fasi  richiede  un  po'  di  tempo per  caricare 
l'immagine ad alta risoluzione, ma permette di lavorare con immagini di qualsiasi 
dimensione.

8.4.2 Gestione dei cataloghi

I cataloghi vengono sempre caricati completamente in memoria. Una sorgente occupa 
approssimativamente 300 byte di spazio. Questo significa che possono essere caricati 1.5 
milioni di sorgenti su una macchina con 1 Gb di RAM. In pratica questo limite si aggira 
sul milione di sorgenti poiché la memoria è condivisa con altre applicazioni.
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Scorciatoie da tastiera
Visualizzazione

Zoom in F8 o rotella del mouse
Zoom out F7 o rotella del mouse
Muovi Alt+Z
Immagine successiva Tab
1 visualizzazione F1
2 visualizzazioni Maiusc+F2
4 visualizzazioni F2
9 visualizzazioni F3
16 visualizzazioni F4
Una visualiz per immagine F9
Corrispondenza scale Alt+S
Rotazione/corrisp scala Alt+Q
Schermo intero F11
Modalità anteprima F12

Strumenti
Stampa Ctrl+P
Lente ingrandimento Ctrl+G
Griglia delle coordinate Alt+G
Sovrapponi informazioni Alt+O
Freccia sull'oggetto Alt+T
Strumento distanza Alt+D

Piani
Proprietà Alt+Enter
Intestazione FITS Alt+H

Sorgenti
Seleziona tutte le sorgenti Ctrl+A
Deseleziona Ctrl+U
Cerca Ctrl+F

Finestra
Apri un file locale Ctrl+O
Carica un'immagine Aladin Ctrl+I
Impostazioni pixel Ctrl+M
Salva Ctrl+S
Cronologia Ctrl+H
Finestra script F5
Chiudi la finestra corrente ESC

Altro
Cancella la selezione Del
Cancella tutto Maiusc+Del
Aiuto sui comandi di script Ctrl+F5
Chiudi Ctrl+W
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NGC 1313, NGC 1808, NGC 2203, NGC 2359,
NGC 2442, NGC 4438, NGC 6070, NGC 253,

Orion nebulea, RCW 38, Hercules cluster, M1,
M16, M65, M83, M96.

Two coloured composition
(DSS2 J/F or R/I)
done by Aladin.
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